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Chapter 1: Introducing the Data Import/Export
Module

The connectivity of the Data Import/Export module makes it possible to import data from many external

applications. When setting up a new system, you can import initial chart of accounts, vendor information,

and customer information. The Data Import/Export module can import many types of transactions

including journal vouchers, cash disbursements, cash receipts, budget transactions, and accounts

payable invoices. With Data Import/Export, you have the flexibility to import data from comma separated

variable (*.csv) file format, automatically generate a session ID number, and apply a date mask to identify

the format of any date.

Balance or transaction data can also be exported in spreadsheet, database, and word processing

formats to many external applications. Data exported from the system can be used for such activities as

outcome-based and performance reporting.

During the import process, if one row in your file contains an error, the import will not fail; instead the

system will create an error exception file. You will be able to select the name of the exception file and

where it will be saved, before the import error log. After correcting the errors, you can re-import this file.

To Add This Module

1. First the Data Import/Export module must be added to the organization by the Administrator.

2. Either add the Data Import/Export module to a current organization (Organization>Add a Module

Wizard - Module Panel), or select the Data Import/Export module when creating a new organization

(File>New Organization Wizard - Modules Panel).

3. Once the Data Import/Export module has been applied to an organization, the Data Import/Export

buttons and menu selections are available. These buttons and menu selections are integrated into

the MIP Fund Accounting system.

4. There are Checklists available for setting up this module and its processes. Please refer to the online

help (Help>Contents and Index>Reference) for modular specific menu selections, checklists, and

common questions.

MIP Fund Accounting

Data Import/Export User's Guide

1

Checklists.htm


Chapter 2: Importing Data

This chapter contains information about importing data into your MIP Fund Accounting system.

Import

Access this form using File>Import.

Use this form to select the definition file (*.DEF) to be imported. Definition files map to data files (fixed

width or comma separated variable) to be imported, while data files contain the actual data being

imported.

Note: To modify one of the master *.DEF or sample *.DEF files provided, copy the file before making

modifications. It is very important to rename the files because all files are replaced during an upgrade of

the system!

Nonprofit Online Users

Files are imported locally through a mapped drive using the \\TS Client\<drive letter> directory

structure. For specific instructions on how to import a file, see article 4136 in the Knowledgebase. See

Nonprofit Online.

Troubleshooting

During the import process, if one row in your file contains an error, the import will not fail; instead the

system will create an error exception file (.CSV or .TXT). Prior to the import error log displaying, the

error exception form opens. You can accept the default name or enter a unique one for the exception

file and where it will be saved. After correcting the errors, you can import this file. For more information

about using the error exception file, see Error Exception File.

Fields

Look in Select the drive and folder for the location of the *.DEF file.

File name Either select a file from the list of files, or enter a file name for the *.DEF file. The system

displays the available *.DEF files in the current folder.

Files of type Either accept the default file type, select a file type from the drop-down list, or enter a valid

file type.
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Tips:
When commands in DEF files are left without column assignments and imported, problems can occur.

Avoid these problems by entering valid default values or REM out the field for values that are not

required.

Once data has been imported, verify the information by opening the appropriate form to be certain all

fields imported correctly.

The import process can be quite lengthy for large data files. The status bar (at the bottom of the

screen) displays the percentage complete.

When attempting to view a CSV using Excel with accounts codes or values having leading zeros, the

leading zero will be stripped off because Excel thinks it is a number.

To add the leading zeros back, highlight the column, right-click and select Format Cells, and create a

Custom format. Enter "0#" in the Type field if the custom format is a two character field; for a three

character field, enter 00# and so on.

Keep in mind if you open the CSV again with Excel to make changes you will have to go through the

same process again.

File Structure
Use the File>Import form in the MIP Fund Accounting system to import data generated by other software

programs, by our system, and by user created entries.

When the system was installed, it automatically created the following file structure.

The Import directory contains the following folders:

3RD PARTY SAMPLES contains folders with *.DEF and data files for fixed assets, fund raising,

payroll, school administration, utility billing, and others. These files include sample *.CSV, *.DEF, and

*.TXT that can be used as a guide, when importing data from other software. Note that these sample

*.DEF files do not contain a predefined error exception file name.

CSV MC Samples contains sample *.DEF and *.CSV files specific to the Multicurrency module. These

files can be viewed to get an idea of how to set up these files when using this module. Note that these

sample *.DEF files do not contain a predefined error exception file name.

CSV SAMPLES contains sample *.DEF and *.CSV files. These files can be viewed to get an idea of

how to set up your own files. Note that these sample *.DEF files do not contain a predefined error

exception file name.



Data Files - CSV Format vs. Fixed-Width Format

FIXEDWIDTH SAMPLES contains sample *.DEF and *.TXT files. It is a good idea to view these files

before importing data into the system. Note that these sample *.DEF files do not contain a predefined

error exception file name.

MASTER DEF FILES has *.DEF files for each import type. Save these files as another name, and then

alter those for your own data. These files contain all possible fields that can be imported into the system.

Also, each one contains a predefined error exception file name.

PT CONVERSION contains *.DEF and data files to help you import Peachtree data into the MIP Fund

Accounting system. Note that these sample *.DEF files do not contain a predefined error exception file

name.

All definition and data files can be imported into the NTO organization, which is available for download.

They are provided to illustrate how a variety of data can be imported. Use the master definition files as a

basis to create or adapt a definition file to use with your Chart of Account structure.

Note: Make a copy of one of the master or sample *.DEF files, and then customize the new file for your

organization. You can also modify or add a predefined error exception file name, if desired.

Tip: During the import process, if one row in your file contains an error, the import will not fail; instead the

system will create an error exception file (.CSV or .TXT). Prior to the import error log displaying, the error

exception form opens. You can accept the default name or enter a unique one for the exception file and

where it will be saved. After correcting the errors, you can import this file. For more information about

using the error exception file, see Error Exception File.

Data Files - CSV Format vs. Fixed-Width Format
Data files must be formatted one of two ways in order to be read by the system; that of Fixed-Width or

Comma Separated Variable (CSV). Each of these formats is read differently by definition files.

It is easy to produce a file in the CSV format with other software programs. Data is separated by commas

(or other delimiters such as colons, semicolons and pipes) in this format.

In the Fixed-Width (FW) format, similar data appears in the same position of each line of data.

The following samples show how to format the exact same data for both a CSV file and a FW file:

CSV Data Sample

The following lines of data are formatted for a CSV data file. Notice that there are commas between each

field:

MIP Fund Accounting
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01-101-40001-101-101-1,04/06/2001,C,1000,FAS Fund-CA

01-101-11001,04/06/2001,D,1000,FAS Fund-CA

01-101-40001-101-101-1,04/06/2001,C,1000,Travel-CA

01-101-11001,04/06/2001,D,1000,Travel-CA

Fixed-Width Data Sample

The following lines of data are formatted for a fixed-width data file. Notice that spaces are used to line the

fields up in the same position:

01 101 40001 101 101 1 04/06/2001 C 1000 FAS Fund-CA

01 101 11001 04/06/2001 D 1000 FAS Fund-CA

01 101 40001 101 101 1 04/06/2001 C 1000 Travel-CA

01 101 11001 04/06/2001 D 1000 Travel-CA

Sections of the *.DEF File
Use the File>Import form to import data into the system. The definition file describes how to interpret the

information contained in the separate data file. The definition and data files can have any filename.

Note: Keep in mind, when you are reviewing a definition file, if a line is preceded by REM, this line is

ignored because the system considers it a remark or comment.

If you are using an existing, master definition file as a starting point, copy the file and change the

segments to match your Chart of Accounts structure. This will allow you to maintain the original files, that

work with the sample data NTO, for future reference. Also note that the master and sample files get

replaced with any system upgrade.

Every definition file contains both the Environment and Context sections. The File, Context ID Position,

File Type, Transaction Line, and Formatting statements are part of the Environment section, while the

Context ID statement makes up the Context section.

Note: This sample *.DEF file contains a predefined error exception file name in the Environment

Section - 1: File Statement. For more information about using the predefined error exception file, see

Error Exception File.



Sections of the *.DEF File

Environment Section

"1: File Statement" (page 8)

FILE,{Record Type},{Path and Filename of Data File}, , {Path and

Filename of Error Exception File}

"2: Context ID Position Statement" (page 9)

CONTEXTIDPOSITION,{Column Position/Field},{Field Length},{Default

Value}

"3: File Type Statement" (page 9)

FILETYPE,{POSLEN OR CSV}

"4: Transaction Line Statement" (page 10)

TRANSACTION_READ,{Method}

"5: Formatting Statements" (page 10)

DISCARDFIRSTNRECORDS,{# of rows to be ignored}

GEN_CODING

APPLY_OFFSETS

CLEANLINE_READ,{1 Enables}

SUPPRESSWARNINGS

SEGMENTNOTSTRING

USEDISTCODE

UPDATEITEM

UPDATETS

PREVALIDATE

MIP Fund Accounting
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Context Section

"6: Context ID Statement - CSV Formatting" (page 15) or "6: Context ID Statement - Fixed-Width

Formatting" (page 20)

CSV:

CONTEXT,{Record Type},{Header or Detail},{Context ID}

{Context Type}_{Field Name},{Field Position in CSV},{Default

Value},{Date Mask},{Position in String},{Field Length},{Decimal

Places}

ENDCONTEXT

Fixed-Width:

CONTEXT,{Record Type},{Header or Detail},{Context ID}

{Context Type}_{Field Name},{Starting Column},{Field Length},

{Default Value},{Decimal Places},{Date Mask}

ENDCONTEXT

Sample DEF File

Note: The following illustration outlines the statements and sections of a definition file. It is NOT

intended to represent an actual definition file. For example, the UPDATEITEM formatting statement

nor the UPDATETS formatting statement should not be used with this type of CSV file, but this is the

correct placement for either statement. This illustration is combining multiple statements into one

example; therefore, its focus is on the placement of the statements, not the data.



Sections of the *.DEF File

1: File Statement

The File statement defines the location of each data file and designates the type of information to be

imported. See the sample File statement below:

FILE,SESSION,C:\MIP SHARE\IMPORT\CSV SAMPLES\T1_TRANS.CSV

This statement can be broken down as follows:

FILE,{Record Type},{path and filename of data file}

FILE and {Record Type} are required, while {path and filename of data file} are not.

If a valid path and filename are not entered in this section, the system displays a form where this

information can be selected.

MIP Fund Accounting
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Note: If the default directory was not used when installing the system, this path needs to be changed to

match the existing CSV SAMPLES and/or FIXEDWIDTH SAMPLES directory. If you do not want to

use some of the import types listed in the definition file, REM them out or delete them.

Troubleshooting

During the import process, if one row in your file contains an error, the import will not fail; instead the

system will create an error exception file (.CSV or .TXT). Prior to the import error log displaying, the

error exception form opens. You can accept the default name or enter a unique one for the exception

file and where it will be saved. After correcting the errors, you can import this file. After correcting the

errors, you can re-import this file. For more information about using the error exception file, see Error

Exception File.

2: Context ID Position Statement

The Context ID Position statement tells the system what type of record is being imported. This statement

identifies the context ID position in the data file. It provides the starting position or field of the Context ID

and the length of the data identifier. A default value for the Context ID Position can also be added. The

line containing this information might look like this:

CONTEXTIDPOSITION,1,6,HCOA

In the preceding example, 1 defines the starting position, 6 defines the length of the ID, and HCOA is the

default value. In a definition file that includes more than one type of Context ID, the length must be equal

to the longest Context IDs in the file.

Note: The Context ID position statement is always required in the definition file. If you are only

importing header records or using the T3 import, you are not required to include the position or length.

But the statement "CONTEXTIDPOSITION" must be included.

3: File Type Statement

The File Type statement defines the type of data file that will be used for import. There are only two

possible statements—CSV or POSLEN. If delimiters, other than the comma, are used in the CSV data

file, add the delimiter here and the system will recognize it.

FILETYPE,CSV,

or

FILETYPE,POSLEN



Sections of the *.DEF File

POSLEN is used with fixed-width data files, while CSV is used with comma separated variable data files. If

this statement is omitted from the definition file, the system use the POSLEN file type by default. If an

alternate delimiter (such as colon, semicolon, or pipe) is not specified here, the system assumes the data

is separated by a comma in the CSV file.

4: Transaction Line Statement

Note: This statement is required for definition files that are used to import accounting transactions. Also,

The PREVALIDATE statement does not apply to transactions.

If you are importing a session or transaction from another software program, the definition file must

contain a TRANSACTION_READ line. The transaction read line must specify which transaction method is

being used—1 or 3.

T1

If you are using the MasterT1.DEF file, the TRANSACTION_READ statement contains a 1. This tells the

import program to read the Session, Header, and Detail information as separate records in the data file.

TRANSACTION_READ,1

T3

If you are using the MasterT3.DEF file, the TRANSACTION_READ statement contains a 3. This tells the

system to read Session, Header, and Detail information from a single flat line. This is the most common

format used.

TRANSACTION_READ,3

5: Formatting Statements

The system allows the following optional statements to be included in the definition file:

DISCARDFIRSTNRECORDS

The DISCARDFIRSTNRECORDS,X statement tells the system to ignore the number of rows (X) in the

data file, starting with row one. X represents the number of rows to be ignored (one or more), not

counting blank lines.

MIP Fund Accounting
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If a line has spaces or blanks in it, it is discarded. If a line is empty, no spaces but a carriage

return/line feed, the system skips it. Therefore, it is not counted as a discarded line and the first line of

data is discarded.

DISCARDFIRSTNRECORDS,1

GEN_CODING

The GEN_CODING statement is used to have the system to automatically generate the line of the

detail coding. This statement can be used in conjunction with the APPLY_OFFSETS statement to

have the system automatically generate all lines. Do not use GEN_CODING if importing Coding

Lines.

Formatting Statement Section of DEF

GEN_CODING

APPLY_OFFSETS

The APPLY_OFFSETS statement is used when only one side of a transaction is available. It tells the

system to automatically apply offsets to transactions to create a balanced entry. If the data file

contains a balanced entry for the transaction, it produces an error message and does not import that

transaction.

APPLY_OFFSETS

From Data File

Gen Journal,01/28/00,01101400011011011,Jan. U. Way,-150.00

Gen Journal,03/28/00,01101400011011011,March U. Way,-200.00

System Generates Offsets

If you include the Apply_Offsets statement in the definition file, and you are using the preceding data

file, the system might produce the following offset to an expense account:

Gen Journal,03/28/00,01101500011011011,Wages,+350.00
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CLEANLINE_READ

The CLEANLINE_READ statement tells the system how to deal with non-required segment

information. When importing transactions, it will remove any segment that is not required by transaction

entry.

A value of "1" enables this feature. Depending on the transaction type, the system updates any

transaction lines to remove non-balancing segment and restriction segment information from lines

where it is not required.

CLEANLINE_READ,1

SUPPRESSWARNINGS

The SUPPRESSWARNINGS statement tells the system not to include warnings in the import log;

consequently, you would not be able to print the warnings either.

However, the system would display error messages that prevent the data from being imported.

SUPPRESSWARNINGS

SEGMENTNOTSTRING

If you include the SEGMENTNOTSTRING statement, the system reads the TETRANS_SEGMENT

data as if it is in CSV format, using the field position. Otherwise, the system processes the file using the

starting position and length.

SEGMENTNOTSTRING

If your DEF file is in CSV format and includes the SEGMENTNOTSTRING statement, it should be set

up as follows:

TETRANS_SEGMENT_GL,10

TETRANS_SEGMENT_FUND,8

TETRANS_SEGMENT_GRANT,9

TETRANS_SEGMENT_PROGR,11

TETRANS_SEGMENT_DEPT,12

TETRANS_SEGMENT_117,13

MIP Fund Accounting
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If your file does not include SEGMENTNOTSTRING, it should be set up as follows:

TETRANS_SEGMENT_GL,10,,,1,5

TETRANS_SEGMENT_FUND,8,,,1,2

TETRANS_SEGMENT_GRANT,9,,,1,3

TETRANS_SEGMENT_PROGR,11,,,1,3

TETRANS_SEGMENT_DEPT,12,,,1,3

TETRANS_SEGMENT_117,13,,,1,1

USEDISTCODE

Note: This statement only applies to CSV data files. Also, you must have previously created

distribution codes using the Maintain>Distribution Codes form.

If you include the USEDISTCODE statement, the system uses both a general ledger code and a

distribution code to complete the accounting transaction lines for each document line imported. You

can include the general ledger and distribution codes in the data file or enter the default code in the

definition file. You can also include user defined fields.

The distribution code should include all Fund, Balancing, Non-Balancing, and Restriction segment

codes. In addition to including USEDISTCODE in the environment section of the definition file, the

Field ID TETRANS_DISTCODE must be added to the transaction line context section. The Field ID

should reference the distribution code in the data file or default to the distribution code to use for all

transactions.

Formatting Statement Section of DEF

USEDISTCODE

Context ID Statement of DEF

TETRANS_DISTCODE
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UPDATEITEM

Note: This statement only applies to Maintain menu selections (such as vendors or customers) and

timesheets; it does not apply to transactions.

If you include the UPDATEITEM statement, the system updates existing records with the data included

in the data file. In other words, the field values in the existing record are replaced by the field values in

the data file. (When importing timesheets the data in the data file appends, or is added to, the existing

record.) Transactions continue to perform a replace import.

Note: When importing detail field data for records, such as Distribution Codes and 1099 Adjustments,

it is recommended that you delete the master record and import the correct information, instead of

updating the existing records using the UPDATEITEM statement. Header records can be imported

using UPDATEITEM.

The UPDATEITEM statement is included after the data path and file name in the File Statement section

of the definition file. The format of the statement is:

FILE,{Record Type},{path and filename of data file}, UPDATEITEM

To update timesheet records, for example, the File Statement would read:

FILE,TIMESHEET,C:\MIP Share\Import\CSV Samples\PRTS.csv,

UPDATEITEM

UPDATEIGNOREBLANK

Note: This statement does not apply to timesheets.

The UPDATEIGNOREBLANK statement tells the system to update fields in a master record with the

contents of the .CSV (data file), except for cases where the data file contains a blank field. If the import

encounters a blank field in the data file, the EXISTING field in the master record will not be replaced

with a blank field. The currently existing value in the organization's database will be kept intact.

UPDATEIGNOREBLANK

UPDATETS

Note: This statement only applies to the Timesheets menu selections; it does not apply to Maintain

menu selections or transactions.

MIP Fund Accounting
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If you include the UPDATETS statement, the import updates the hours and/or rates/amounts on

timesheets. When importing timesheets the data in the data file appends, or is added to, the existing

record. For example: On Default timesheets, Earnings Hours can be appended and Distribution

Codes can be modified, and new Codes can be added.

The UPDATETS statement is included after the data path and file name in the File Statement section

of the definition file. The format of the statement is:

FILE,TIMESHEET,{path and filename of data file}, UPDATETS

PREVALIDATE

Note: This statement only applies to Maintain menu selections (such as vendors or customers) and

timesheets; it does not apply to transactions.

If you include the PREVALIDATE statement, the system tests the definition and data files without

actually importing the data. If errors are detected, they are displayed in a message box. If there are no

errors, the system displays a blank message. This statement should be on a separate line under the

File Type statement.

PREVALIDATE

6: Context ID Statement - CSV Formatting

The data below describes the context ID statement, identifies CSV field references, provides excerpts

from sample data and DEF files, and helps you interpret a sample DEF file:

Context ID Statement

In the definition file, the next block of lines begins with CONTEXT and ends with ENDCONTEXT. This

tells the import program that a new block of text (to define a new set of records) is included in that

block.

The first line, beginning with CONTEXT, shows the record type that the system recognizes, whether

the records are Header or Detail, and the Context ID.

In the following example, Sessions are imported, all records are Header records, and the Context ID

to be used is HSESSN.

CONTEXT,SESSION,HEADER,HSESSN



Sections of the *.DEF File

SESSION_SESSIONNUMID,,AUTONUM

SESSION_STATUS,,BP

SESSION_DESCRIPTION,,Import from RE

SESSION_SESSIONDATE,2,,mm/dd/yyyy

SESSION_TRANSSOURCEID,,CR

ENDCONTEXT

The number of characters identified for the Header—"HSESSN" in this example—cannot be longer than

the Context ID position (6 in this case), which is declared in the Context ID Position statement in the

Environment section.

CSV Field References

Field references are located between the CONTEXT and ENDCONTEXT statements. They contain

seven field positions, separated by commas and read from left to right. The following table outlines

each possible field position:

Field Position Comma Separated Variable

1 Context Type and Field Name

2 Field Position in CSV

3 Default Value

4 Date Mask

5 Position within string

6 Field Length

7 Assumed Decimal Places

Note: Field reference positions are different for fixed-width and CSV data files. See the section

entitled "Context ID Statement—Fixed-Width Formatting" for fixed-width examples.

Here is an example of a field reference from a definition File:

MIP Fund Accounting
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1 2 3 4 5 6 7

SESSION_SESSIONDATE, 2, , mm/dd/yyyy, , ,

Below you will find three sections related to CSV Formatting—a sample data file, a sample definition

file, and an interpretation table. All of this information is related to each other—the sample definition

file can be used to import the sample data file. And, the Interpretation table outlines how the

information is being read by the system.

Sample CSV Data File

The following lines are from a sample data file. Notice that commas separate each field of data:

01-101-40001-101-101-1,04/06/2001,C,1000,FAS Fund-CA

01-101-11001,04/06/2001,D,1000,FAS Fund-CA

01-101-40001-101-101-1,04/06/2001,C,1000,Travel-CA

01-101-11001,04/06/2001,D,1000,Travel-CA

Note: We recommend limiting your data to strictly alphabetic characters (A through Z) or numeric

characters (0 through 9), and avoiding the use of symbols.

Sample CSV DEF File

Below is an excerpt from a DEF file. This is NOT a complete definition file; it only contains the Context

ID Statement for instructional purposes. It is mapped to the preceding sample data file.

CONTEXT,TRANSENTRY,DETAIL,DDOC

TETRANS_SESSIONNUMID,,Autonum

TETRANS_DOCNUM

TETRANS_DESCRIPTION,7

TETRANS_ENTRY_TYPE,,N

TETRANS_EFFECTIVEDATE,2,,mm/dd/yyyy

TETRANS_SEGMENT_GL,1,,,8,5
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TETRANS_SEGMENT_Grant,1,,,4,3

TETRANS_SEGMENT_Fund,1,,,1,2

TETRANS_SEGMENT_Progr,1,,,14,3

TETRANS_SEGMENT_Dept,1,,,18,3

TETRANS_SEGMENT_117,1,,,22,1

TETRANS_DEBIT,4,0,,,,0

TETRANS_CREDIT,4,0,,,,0

ENDCONTEXT

Interpretation of Sample CSV DEF File

Based on the definition file below, and the first line in the preceding sample data file, here is how the

system reads the data:

Field Name Field

Pos

Default Date String

Pos

Length Decimal 1st Line

Actual Data

TETRANS_

SESSIONNUMID

N/A

TETRANS_

DOCNUM

N/A

TETRANS_

DESCRIPTION

5 FAS Fund-

CA

TETRANS_

ENTRY_TYPE

N

TETRANS_

EFFECTIVEDATE

2 mm/dd/yyyy 04/06/2001

TETRANS_

SEGMENT_GL

1 8 5 40001
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Field Name Field

Pos

Default Date String

Pos

Length Decimal 1st Line

Actual Data

TETRANS_

SEGMENT_

GRANT

1 4 3 101

TETRANS_

SEGMENT_FUND

1 1 2 01

TETRANS_

SEGMENT_

PROGR

1 14 3 101

TETRANS_

SEGMENT_DEPT

1 18 3 101

TETRANS_

SEGMENT_117

1 22 1 1

TETRANS_DEBIT 4 0 0

TETRANS_

CREDIT

4 0 0 1000

Field Name This is the field name that is required by the Import program. It cannot be changed.

Field Position in CSV File This is the order in which the fields are organized. Unlike fixed-width data

files, CSV files are organized by fields, not characters.

An account code will generally appear as a string in a single field. Within that field, identify the start

position and length for each of the segments.

Default Value Specify a default value; however, this is not required.

Date Mask Indicate the format for date fields—MMDDYY, MMDDYYYY, MM/DD/YYYY, or MM-DD-

YYYY.

Position within String Use this designation to specify the begin position of subsets within a field.

Field Length This is the length of the data position within the field. This length was assigned when the

organization was created. If the data length exceeds the field lengths specified, the system displays

an error to that affect.
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Assumed Decimal Places Indicate the number of decimal places in currency fields. If the decimal is

supplied with the data, enter 0.

6: Context ID Statement - Fixed-Width Formatting

The data below describes the context ID statement, identifies Fixed-Width field references, provides

excerpts from sample data and DEF files, and helps you interpret a sample DEF file:

Context ID Statement

In the definition file, the next block of lines begins with CONTEXT and ends with ENDCONTEXT. This

tells the import program that a new block of text (to define a new set of records) is included in that block.

The first line, beginning with CONTEXT, shows the record type that the system recognizes, whether the

records are Header or Detail, and the Context ID.

In the following example, Sessions are imported, all records are Header records, and the Context ID to

be used is HSESSN:

CONTEXT,SESSION,HEADER,HSESSN

SESSION_SESSIONNUMID,1,6

SESSION_STATUS,9,2

SESSION_DESCRIPTION,132,30,Imported Session

SESSION_SESSIONDATE,24,10

SESSION_TRANSSOURCEID,34,3

ENDCONTEXT

The number of characters identified for the Header—"HSESSN" in this example-cannot be longer than

the Context ID position (6 in this case), which is declared in the Context ID Position statement in the

Environment section.

In this case, for Session records, the import program looks in the data file, specified at the beginning of

the definition file, for all lines beginning with the Header identifier HSESSN.

Fixed-Width Field References

Field references are located between the CONTEXT and ENDCONTEXT statements. They contain six

field positions, separated by commas and read from left to right. The following table outlines each
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possible field position:

Field Position Fixed Width

1 Context Type_Field Name

2 Position of data begins

3 Field Length

4 Default values

5 Assumed decimal places

6 Date Mask

Note: Field reference positions are different for fixed-width and CSV data files. See the section

entitled "Context ID Statement—CSV Formatting" for CSV examples.

Here is an example of a field reference from a definition File:

1 2 3 4 5 6

TETRANS_DEBIT, 80, 6, 0, 2,

Below you will find three sections related to Fixed-Width Formatting—a sample data file, a sample

definition file, and an interpretation table. All of this information is related to each other—the sample

definition file can be used to import the sample data file. And, the Interpretation table outlines how the

information is being read by the system.

Sample Fixed-Width Data File

The following lines are from a sample data file. Notice that the data is set at a fixed-width.

CD-130 BP Jan supplies 01/10/1999 CD 20160 ABC N 11001 01

201 00000 10100

CD-130 BP Jan supplies 01/10/1999 CD 20160 ABC N 57001 01

201 101 101 1 10100 00000

CD-131 BS Telephone 01/12/1999 CD 20161 BELL N 11001 01

201 00000 23500
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CD-131 BS Telephone 01/12/1999 CD 20161 BELL N 56001 01

201 101 101 2 23500 00000

CR-150 BP Copy Income 01/14/1999 CR 50010 EDUCATION N 11001 01

201 35000 00000

CR-150 BP Copy Income 01/14/1999 CR 50010 EDUCATION N 40001 01

201 101 101 1 00000 35000

CR-151 BS Interest Inc 01/16/1999 CR 50011 YOUTHTRAIN N 11001 01

201 04500 00000

CR-151 BS Interest Inc 01/16/1999 CR 50011 YOUTHTRAIN N 45001 01

201 101 101 2 00000 04500

Note: We recommend limiting your data to strictly alphabetic characters (A through Z) or numeric

characters (0 through 9), and avoiding the use of symbols.

Sample Fixed-Width DEF File

Below is an excerpt from a DEF file. This is NOT a complete definition file; it only contains the Context

ID Statement for instructional purposes. It is mapped to the preceding sample data file.

CONTEXT,TRANSENTRY,DETAIL,DDOC

TETRANS_SESSIONNUMID,1,7

TETRANS_DOCNUM,38,6

TETRANS_DESCRIPTION,11,13

TETRANS_ENTRY_TYPE,55,2,N

TETRANS_EFFECTIVEDATE,24,10

TETRANS_SEGMENT_GL,57,5

TETRANS_SEGMENT_Fund,63,2

TETRANS_SEGMENT_Grant,66,3
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TETRANS_SEGMENT_Progr,70,3

TETRANS_SEGMENT_Dept,74,3

TETRANS_SEGMENT_117,78,1

TETRANS_DEBIT,80,6,0,2

TETRANS_CREDIT,86,5,0,2

ENDCONTEXT

Interpretation of Sample Fixed-Width DEF File

Based on the definition file below, and the first line in the preceding sample data file, here is how the

system reads the data:

Field Name Data

Pos

Length Default Decimal Date Mask Actual Data

TETRANS_

SESSIONNUMID

1 7 CD-130

TETRANS_DOCNUM 38 6 20160

TETRANS_

DESCRIPTION

11 13 Jan supplies

TETRANS_ENTRY_

TYPE

55 2 N N

TETRANS_

EFFECTIVEDATE

24 10 mm/dd/yyyy 01/10/1999

TETRANS_SEGMENT_

GL

57 5 11001

TETRANS_SEGMENT_

FUND

63 2 01

TETRANS_SEGMENT_

GRANT

66 3 201
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Field Name Data

Pos

Length Default Decimal Date Mask Actual Data

TETRANS_SEGMENT_

PROGR

70 3

TETRANS_SEGMENT_

DEPT

74 3

TETRANS_SEGMENT_

117

78 1

TETRANS_DEBIT 80 6 0 2 00000

TETRANS_CREDIT 86 5 0 2 10100

Field Name This is the field name that is required by the Import program. It cannot be changed.

Position of Data Begins This is the starting position for the first character or number of the field's data

found in the data file. This is the number of spaces from the left.

Field Length This is the length of the data position within the field name defined by the system. This

length was assigned when the organization was created. If field lengths are exceeded, data is

truncated.

Default Values Specify a default value; however, this is not required.

Assumed Decimal Places Indicate the number of decimal places in currency fields.

Date Mask Indicate the format for date fields—MMDDYY, MMDDYYYY, MM/DD/YYYY, or MM-DD-

YYYY.

If you are importing any data file and a field is left blank, the system automatically uses the default

characters (if there are any) from the definition file. However, not all fields allow the use of the default.

Note: Often the data files contain information that is irrelevant to the system. These fields can be left

in the data files; the location of data must be defined in the definition file for it to be imported into the

system.

Error Exception File
During the import process, if a row in your file contains an error, the import will not fail; instead the system

will create an error exception file. Prior to the import error log displaying, the error exception form opens.
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You can accept the default name or enter a unique one for the exception file and where it will be saved.

Use this file to import after you have corrected the errors.

Procedures

The following shows how the error exception file is created if one or more rows in a file fail to import.

1. During the import process, if your file contains an error, the line will be extracted into an error

exception file. The import process will continue importing and extracting all of the errors.

2. The system will create an error exception file. You can select the name of the exception file and

where it will be saved. Or you can accept the default file name and location. (This will be the same

place your data file is located.) The default is the name of the original .csv or .txt file with ERR and a

date and time stamp. For example, ChgCdERR20140827142947.csv

3. Afterward, the import error log displays. This log is not saved after clicking OK. Make note of the

errors or print (Ctrl+P) them before closing this message.

To complete your import session:

1. Open the error exception file.

2. Make your corrections to this file.

3. Either rename it, if your .DEF file calls a specific file name; or change the .def file to import the error

exception file.

4. Restart the import process using the .def and the newly corrected file.

Note: The system will continue to check the import file and continue to create exception files, until

all of the errors are fixed and the import completes.

For example, if the import file has subsets and the main set fails, all subsets will NOT be imported.

However, they will be included in the error exception file. Once the main set is corrected, you can re-

import it along with the associated subsets.

Troubleshooting:

An error exception file will not be created, nor will a file be imported, if one of the following is met:

The structure of the import file is not correct.

Every row in the file contained an error.

The data being imported has an unmet prerequisite.
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Fields
Select the Location and Name of the Error File for: The system displays the import file name.

File Name: Accept the default or enter the file name for the error exception file being created.

Tip: When attempting to view a CSV using Excel with accounts codes or values having leading zeros,

the leading zero will be stripped off because Excel thinks it is a number.

To add the leading zeros back, highlight the column, right-click and select Format Cells, and create a

Custom format. Enter "0#" in the Type field if the custom format is a two character field; for a three

character field, enter 00# and so on.

Keep in mind if you open the CSV again with Excel to make changes you will have to go through the

same process again.

Predefined Error Exception File

During the import process, if at least one row in your file contains an error, the import will not fail; instead

the system will create an error exception file. Prior to the import error log displaying, the error exception

form opens. You can accept the default name or enter a unique one for the exception file and where it will

be saved. Use this file to re-import after you have corrected the errors.

Instead of having to select a location and naming the exception file, you can create a predefined name for

the error exception file in the original .DEF file.

Important! Every time the import file fails, your existing information will be replaced by the latest failure

information. Note that you will only get the import error log as your notice to open your named error

exception file. As a best practice, consider changing your procedures to include time between imports to

open the error exception file, make corrections, and re-import the information before importing a new

file.

Note: With a defined path and filename for the Error Exception File in the original.DEF file, you will NOT

be reminded that this exists. The system will continue to display an import error log and that is your only

reminder/notification to review the error exception file. If you do not make the corrections and re-import

the error exception file before importing a new file using the same .DEF file, any new errors will overwrite

the error exception file.

This File statement defines the location of each data file, designates the type of information to be

imported, and includes a predefined location and name for the error exception file. See the sample File

with a predefined error exception statement below:
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FILE,SESSION,C:\MIP SHARE\IMPORT\CSV SAMPLES\T1_TRANS.CSV, ,{Path

and Filename of Error Exception File}

This creates a predefined name for the error exception file in the original .DEF file.

Important! Every time the import file fails, your existing information will be replaced by the latest

failure information. So it is important to change your import procedures to include checking this named

file after every import, immediately after you receive an error message.Than you can use this file to re-

import after you have corrected the errors, before continuing to your next import session.

Tip: Because the system will replace the existing predefined error exception file when an import file

fails, you might consider not creating the predefined error exception information if you plan to import

using the same .DEF file repeatedly in one session. That way the system gives you the opportunity to

uniquely name the failed import within a session, if a failure to import occurs.

Tip: When attempting to view a .CSV using Excel with accounts codes or values having leading zeros,

the leading zero will be stripped off because Excel thinks it is a number.

To add the leading zeros back, highlight the column, right-click and select Format Cells, and create a

Custom format. Enter "0#" in the Type field if the custom format is a two character field; for a three

character field, enter 00# and so on.

Keep in mind if you open the .CSV again with Excel to make changes you will have to go through the

same process again.

After Import
The following sections provide information related to resolving import errors and issues.

Error Log

If any errors were encountered during import, the system displays a log. This log is not saved after

clicking OK. Make note of the errors or print (Ctrl+P) them before closing this message.
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Note: Warnings can be excluded from this log by adding the ""SUPPRESSWARNINGS" (page 12)"

formatting statement to the definition file.

Import Errors

Below you will find an explanation of the columns found in the Import log:

Data Type The system displays the type of data that could not be imported. In this example, the data

type is "COACODE" (Maintain>Chart of Accounts Codes).

Action The system displays both warnings and errors by listing "Imported or "Not Imported",

respectively. Although, the message for warnings is "Imported," the system still informs you of the

warning.

Code/ID The system displays what context detail line in the definition file is causing the error. In this

example, COA_SEGID", is failing.

Field Edited The system displays a description of the Code/ID (if available) causing the error.

Field Value The system displays what is in the data file for that particular context detail.
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Message You will receive a message as to why import is giving you an error or warning.

Resolution The system gives you a resolution as to a cause of the error or warning.

Special Considerations

Below you will find a list of special fields and formatting to consider when creating your definition

and data files:

AutoNum

If a session or number value is not provided in the data file and AutoNum is included in the definition file,

the system automatically generates a number using the AutoNum feature. AutoNum uses the next

sequential session for each transaction type. The system tracks the last number used setup by the

Administrator using the Organization>Organization Preferences form and will auto-increment from this

number, similar to the way the plus (+) key works in the Session form.

If neither the Session ID nor the Document Number are supplied in the data, the same number

generated for the Session ID will also be used for the Document Number. To accomplish this, make no

reference to the location in the data file for the Document Number.

Credit/Debit

In data files, debits and credits can appear in one of the following ways:

Different Positions

In the following example, debits and credits appear in positions 9 (for the first two lines) and 10 (for

the last two lines):

CSV Data File Sample

Detail,01-101-11000,,,100,,100801,200114,125.36,0

Detail,01-101-11000,,,,,100801,200114,1800.00,0

Detail,01-101-40001-101-101-1,,,100,,100801,200114,0,125.36

Detail,01-101-40001-101-101-1,,,,,100801,200114,0,1800.00

CSV *.DEF File Sample
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TETRANS_DEBIT,9,0,,,,0

TETRANS_CREDIT,10,0,,,,0

Same Position—Distinguished by - and +

In the following example, debits and credits appear in the same position (6) and credits are

distinguished by a minus (-) sign:

CSV Data File Sample

07/18/01,From United Methodist,2,0110111001,,100.00

07/18/01,From United Methodist,2,01101400011011011,,-100

07/18/01,From United Methodist,2,0110111001,,25.00

07/18/01,From United Methodist,2,01101400011011011,,-25

07/18/01,From United Methodist,2,0110111001,,35.00

07/18/01,From United Methodist,2,01101400011011011,,-35

CSV *.DEF File Sample

TETRANS_DEBIT,6,0,,,,0

TETRANS_CREDIT,6,0,,,,0

Same Position—Distinguished by Debit or Credit

In the following example, debits and credits appear in the same position (3) and are distinguished by a

letter or series of letters that is clearly described in the definition file.

However credit (such as C, CR, or Credit) and debit (such as D, DR, or Debit) are identified in the data

file, must match the TETRANS flag in the *.DEF file.

CSV Data File Sample

01-101-40001-101-101-1,04/06/2001,C,10.00,,FASE Dean's Fund-Cash,

01-101-11001,04/06/2001,D,10.00,,FASE Dean's Fund-Cash,
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01-101-40001-101-101-1,04/06/2001,C,10.00,,Night in New Orleans-

Cash,

01-101-11001,04/06/2001,D,10.00,,Night in New Orleans-Cash,

CSV *.DEF File Sample

TETRANS_CREDIT_FLAG,C

TETRANS_DEBIT_FLAG,D

TETRANS_AMOUNT_INDICATOR,3,D

TETRANS_DEBIT,4,,,,,0

TETRANS_CREDIT,4,,,,,0

The definition file must contain all five of these lines. Notice that the amount indicator contains a D.

Because the D is in the third position, the system defaults to debit.

Note: If a fixed-width data file is used, the TETRANS_AMOUNT_INDICATORmust include the

position, length, and default.

Date Masks

The date mask feature is provided for flexibility in accommodating date formats. The system accepts a

wide range of date masks.

With definition files that use a fixed-width data file, the system reads dates according to their length.

6 digits is read as mmddyy (See MMDDYY or YYMMDD)

8 digits is read as mmddyyyy (See MMDDYYYY, YYYYMMDD, or MM/DD/YY)

10 digits is read as mm-dd-yyyy (See MM/DD/YYYY)

Note: If an invalid date is entered, the system date is used.

Use the following samples to determine how to enter a date mask in both definition and data files:
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MMDDYY

Data File Sample

01-101-40001-101-101-1,040601,C,1000,March Training

01-101-11001,040601,D,1000,March Training

*.DEF File Sample

SESSION_SESSIONDATE,2,,mmddyy

YYMMDD

Data File Sample

01-101-40001-101-101-1,010406,C,1000,March Training

01-101-11001,010406,D,1000,March Training

*.DEF File Sample

SESSION_SESSIONDATE,2,,yymmdd

MMDDYYYY

Data File Sample

01-101-40001-101-101-1,04062001,C,1000,March Training

01-101-11001,04062001,D,1000,March Training

*.DEF File Sample

SESSION_SESSIONDATE,2,,mmddyyyy
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YYYYMMDD

Data File Sample

01-101-40001-101-101-1,20010406,C,1000,March Training

01-101-11001,20010406,D,1000,March Training

*.DEF File Sample

SESSION_SESSIONDATE,2,,yyyymmdd

MM/DD/YY

Data File Sample

01-101-40001-101-101-1,04/06/01,C,1000,March Training

01-101-11001,04/06/01,D,1000,March Training

*.DEF File Sample

SESSION_SESSIONDATE,2,,mm/dd/yy

Note: Hyphens (-) can be used in place of slashes (/).

MM/DD/YYYY

Data File Sample

01-101-40001-101-101-1,04/06/2001,C,1000,March Train

01-101-11001,04/06/2001,D,1000,March Train

*.DEF File Sample

SESSION_SESSIONDATE,2,,mm/dd/yyyy
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Amounts and Decimals

When importing currency amounts, many different numeric formats can be used.

Explicit Decimal Places Decimal points can be explicitly noted in the external data file, for example, $100

(USD) would be noted as 100.00.

Implied Decimal Places An implied number of decimal places can be specified in the definition file

(position 5 in fixed-width formatted data files and position 7 in CSV formatted data files), such as the

following example:

TETRANS_CREDIT,5,0,,,,2

If "2" is noted as the implied number of decimal places in the definition file, "10000" would be interpreted

as 100.00.

If a decimal point is provided in the data file and a number other than zero is indicated as the implied

number of decimal places or it is left out, the import process moves the decimal point to the left of the

number of spaces indicated by the value in this position. For example, if the implied decimal place is two

(2) but the value provided in the definition file is "00900.00," the value imported would be 9.00.

Commas Instead of Decimals

The currency formatting used throughout the system is based on the settings specified by the

Administrator using the Organization>Currency Setup form. You can set up different currency formatting

for each currency type (such as USD or CAD) used in the system. To determine the decimal and grouping

symbols used in reports, also use this form.

Other decimal and grouping symbols (such as the period and comma), found throughout the system,

follow the computer's regional settings (Start>Settings>Control Panel>Regional Options or Control

Panel>Change date, time, or number formats>Additional Settings Button). All non-currency numbers

follow the computer's regional settings as well.

Note that if you are using regional settings with a comma in place of a decimal point (such as with EUR or

CRC), the data will not import. You must change the regional settings to a period, import the data, and

then change it back to a comma.

User Defined Fields

User defined fields (UDFs) are custom fields created by the user that apply to segment codes, vendors,

customers, purchase orders, assets, charge codes, employees, transaction documents, or transaction

MIP Fund Accounting

Data Import/Export User's Guide

34



Chapter 2: Importing Data

MIP Fund Accounting

Data Import/Export User's Guide

35

lines. Although user defined fields (UDFs) themselves cannot be imported, UDF data can be imported.

Data File

When importing UDF data, the field attributes defined by the user (UDFs were set up by the

Administrator using Organization>Set Up User Defined Fields) determine both the edits applied to the

import process and the data file requirements.

When importing Grant chart of account codes, a Grant Award date with a MM/DD/YY format is required.

If no date is included in the data file, an error is generated and the grant code fails to import. A sample

CSV data file is presented below.

Sample UDF CSV Data File

Context ID,Segment,Code,Title,S Title,Acct Type,Award Date

HCOA,Grant,401,Job Skills Training,JST,,10/01/03

HCOA,Grant,501,Transportation Allowance,TransAll,,10/01/03

HCOA,GL,58006,Non Employee Registation,NE Registation,EXP

HCOA,GL,58007,Non Employee Travel,NE Travel,EXP

HCOA,GL,58008,Non Employee Meals,NE Meals,EXP

To minimize potential errors, carefully review the UDF setup information prior to importing UDF data

(UDFs were set up by the Administrator using Organization>Set Up User Defined Fields).

Definition File

The context section of the definition file contains the [Context Type]_[Field Name] (referred to as the

Field ID) of each field to be imported into the system. For example, the Field ID for importing a vendor ID

is VENDOR_ID. The Master Definition files, installed with the system, contain the Field IDs for all system

defined fields. UDF Field IDs are not included in the Master Definition files. To import UDF data, the UDF

Field ID must be added to your definition file.

The Field ID for a UDF is assigned by the system when a UDF is saved. To determine the Field ID, have

the Administrator print a User Defined Field List report (Reports>Lists>User Defined Fields) including

"Field ID" in the report body.
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The Field ID for segment, vendor, charge code, employee, and customer UDFs should be added to the

Header context section of the definition file. The Field ID for transaction documents or transaction lines

should be added to the related context section of the definition file.

Sample Definition File for Grant UDF

FILE,COACODE

CONTEXTIDPOSITION,1

FILETYPE,CSV

DISCARDFIRSTNRECORDS,1

CONTEXT,COACODE,HEADER,HCOA

COA_SEGID,2

COA_CODE,3

COA_STATUS,,A

COA_TITLE,4

COA_SHORT_TITLE,5

COA_TYPE,6

Segment Code:2:AwardDate,7,,MM/DD/YY

ENDCONTEXT

Years

Two-digit year values require special handling. If the two-digit year is greater than or equal to 50, then the

date is assumed to be in the 1900s. If the two-digit year is greater than or equal to 00 and less than or

equal to 49, then the date is assumed to be in the 2000s.

Header and Detail Records

Header records and detail records have identifiers. For example, when you import vendors there is the

header identifier (HVEND) and the detail identifier (DVEND).
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When you import new Vendor ID header records (with or without detail records), any Vendor ID

beginning with “D” will not import because the import process thinks it is a detail record, such as

(DollarTree, A, Dollar Tree…). In this case, since there is no matching header, the record is not imported.

In order to tell the import process there is no detail record, the first field in the record must be the

applicable header identifier (HVEND, DollarTree, A, Dollar Tree…).

Choosing a Sample *.DEF File
When the product was installed, the system automatically copied master *.DEF files into the

Import\Master DEF Files directory—MasterAB.DEF, MasterAP.DEF, MasterAR.DEF, MasterBK.DEF,

MasterFA.DEF, MasterGL.DEF, MasterInvAdj.DEF, MasterMCRATE, MasterOE.DEF, MasterPO.DEF,

MasterPR.DEF, MasterT1.DEF, and MasterT3.DEF.

The master *.DEF files, which are designed to work with *.CSV data files, list all fields available for

import. You can make a copy of the master *.DEF file (\Import\Master DEF Files) that applies to your

import, and then customize it to fit your needs. Also, each one contains a predefined error exception file

name. For more information about using the predefined error exception file, see Error Exception File.

Note that the 3rd Party Samples directory (\MIP SHARE\IMPORT\3RD PARTY SAMPLES) contains

CSV (comma separated variable) and fixed-width formatted data files, and corresponding *.DEF files for

importing data from other software. You can make a copy of these DEF and data files, and then

customize them. Note that these sample *.DEF files do not contain a predefined error exception file

name.

Alternatively, you can review and/or copy sample *.DEF and data files to get an idea of how to set up

your own.

For CSV samples, copy the *.DEF and *.CSV files from \Import\CSV Samples.

For currency-specific CSV samples to be used with the Multicurrency module, copy the *.DEF and

*.CSV files from \Import\CSV MC Samples.

For fixed-width samples, copy the *.DEF and *.TXT files from \Import\Fixed Width Samples.

Note: These sample *.DEF files do not contain a predefined error exception file name. Only the master

*.DEF files contains the predefined error exception file.
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The following sample *.DEF files can be used to import the designated data:

Sample File Header/Detail

Records

Record Type Data Imported

SampleGL.DEF Header COACODE Chart of Accounts

Header CLOSEACCT Closing Account

Assignments

Header OFFSET Offset Account

Assignments

Header/Detail DISTCODE Distribution Codes

Header CHKSPOIL Check Spoilage

Header EMAILTEMPLATE Email Template

SampleAP.DEF Header/Detail VENDOR Vendors

Header VENDADDR_CODES Vendor Check

Address

SampleAR.DEF Header CUSTOMER Customers

Header CUSTOMERSHIPADDR Customer Ship

Address

SampleAB.DEF Header/Detail CHARGECODE Charge Codes

Header/Detail ONETIMECHARGES One Time Charges

SampleBK.DEF Header BKREC Bank Reconciliation

Items

SampleFA.DEF Header DESGCODES Designation Codes

Header ASSETS Asset Codes

Header FATYPE Asset Types

Header/Detail FADEPR Custom

Depreciation Codes

SampleInvAdj.DEF Header/Detail INVADJMENT Inventory
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Sample File Header/Detail

Records

Record Type Data Imported

Adjustment

SampleOE.DEF Header/Detail OENTRY Sales Order Entry

SampleT1.DEF Header

Header/Detail

SESSION Session, Header,

Detail Transactions

Sample T1USEDIST.DEF Header

Header/Detail

SESSION Session Header,

Detail Transactions

Using Distribution

Codes

SampleT3.DEF Header

Header/Detail

SESSION Session, Header,

Detail Transactions

SampleT3ENL.DEF Header

Header/Detail

SESSION Session, Header,

Detail Transactions -

Encumbrance

Liquidations

SampleT3USEDIST.DEF Header

Header/Detail

SESSION Session, Header,

Detail Transactions

Using Distribution

Codes

SampleT3JV.DEF Header

Header/Detail

SESSION Session, Header,

Detail Transactions -

Journal Vouchers

SamplePO.DEF Header ITEMCODES Item Codes
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Sample File Header/Detail

Records

Record Type Data Imported

SamplePR.DEF Header/Detail DISTCODE Distribution Codes

Header PGRPCODE Processing Group

Codes

Header EARNINGCODE Earning Codes

Header/Detail BENEFITCODE Benefit Codes

Header DEDUCTIONCODE Deduction Codes

Header/Detail WORKCOMPCODE Workers' Comp

Codes

Header/Detail LEAVECODE Leave Codes

Header STATETAX State Tax Codes

Header/Detail LOCALTAX Other Tax Codes

Header/Detail EMPLOYEE Employee

Information

Header/Detail TIMESHEET Timesheet

Header/Detail ADJUSTBALANCES Adjust Employee

Balances

Note: We suggest that separate *.DEF and data files be set up for each record type. For example, a

separate file should be set up for COACODE (Chart of Accounts Records) and VENDOR (Vendor

Records).

Multicurrency Sample Files

If you have installed and added the Multicurrency module, you may want to use the following sample

DEF files which are found in the \MIP Share\Import\CSV MC Samples\ directory. These files include

currency-specific fields that apply to the Multicurrency module.
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Sample File Header/Detail

Records

Record Type Data Imported

SampleABMC.DEF Header/Detail CHARGECODE Charge Codes

Header/Detail ONETIMECHARGES One Time Charges

SampleAPMC.DEF Header/Detail VENDOR Vendors

SampleARMC.DEF Header CUSTOMER Customers

SampleGLMC.DEF Header COACODE Chart of Accounts

Header CLOSEACCT Closing Account

Assignments

Header OFFSET Offset Account

Assignments

Header/Detail DISTCODE Distribution Codes

Header CHKSPOIL Check Spoilage

SamplePOMC.DEF Header ITEMCODES Item Codes

SampleRATEMC.DEF Header MCRATE Exchange Rate

SampleT1MC.DEF Header

Header/Detail

SESSION Session, Header, Detail

Transactions
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This topic reviews all types of data that can be imported, and gives specific information about the *.DEF

file's syntax. If a field is required, and its syntax is not provided in the *.DEF file (the field reference),

Import will be terminated. In certain instances, if a field is not required and no data is present in any

record to be imported for the field, you cannot leave it undefined. You must REM out or delete the line in

the *.DEF file.

Field sizes are values and they are not necessarily those that apply to the organization being imported.

The Administrator can see an organization's user defined values, using the Organization>Organization

Information>Field Lengths tab.

Note: We recommend limiting your data to strictly alphabetic characters (A through Z) or numeric

characters (0 through 9), and avoiding the use of symbols.

The General Ledger Module Data Fields
The following are specific data field tables used to import data into the General Ledger module:

Importing Chart of Accounts

Chart of Account Codes should always be imported first. The following table defines the field references

to be used in the Chart of Accounts section of the MasterGL.DEF file:

Note: Segments (such as Fund, or GL) have to be set up in the system prior to Import. Segments were

set up when the organization was created. To view the segment information defined for an organization,

with Administrative user rights see the Organization>Organization Information - Segments Tab.

Table: tblAccountCode_N

Context Section: CONTEXT,COACODE,HEADER,HCOA

Field ID Req'd Field

Length

Default

Value

Notes

COA_SEGID Y User

Defined

Segment Name

COA_CODE Y User

Defined

Account Code
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Table: tblAccountCode_N

Context Section: CONTEXT,COACODE,HEADER,HCOA

Field ID Req'd Field

Length

Default

Value

Notes

COA_STATUS Y 2 A A (Active), I (Inactive), or D

(Discontinued)

COA_TITLE Y User

Defined

Account Title

COA_SHORT_TITLE N 15 Account Short Title

COA_TYPE Y 3 Required for GL. Account Types:

CSH, AR, ARO, PLO, IFR, FAO, OA,

AP, APO, IFP, OL, NAE, REV, EXP,

or IFT

COA_DESIGNATION Y 3 Required for general ledger

segments and segments with a

Function of Restriction or Program.

See Maintain>Chart of Accounts

Codes for a list of designation codes.

COA_990LN Y 25 The Form 990 Line Number reflects

the line number that correlates to the

990 form version (Form 990EZ or

Form 990) selected by the

Administrator using the

Organization>Organization

Information form. If Form 990 is

selected, a line number is required

for general ledger segments and

segments with a Function of

Restriction or Program

(Organization>Organization

Information - Segments Tab). If the

Form 990EZ is selected, a line
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Table: tblAccountCode_N

Context Section: CONTEXT,COACODE,HEADER,HCOA

Field ID Req'd Field

Length

Default

Value

Notes

number is only required for general

ledger segments. See IRS Form 990

Line Number or Column Letter for a

list of Form 990 Line Numbers.

COA_CHK_NUM N 15 Last Used Check Number only

available for General Ledger cash-

type accounts.

COA_CURRENCY Y* 3 Active or inactive Currency code.

Required for CSH-type General

Ledger accounts.

COA_GA_STAGE N 2 Required. Stages: Pre-award (PR),

Post-award (PO), or Close-out (CL).

COA_GA_ACCTNUM N 50 Account Number

COA_GA_PROJDIR N 80 Project Director

COA_GA_AWDTYPE N 50 Award Type

COA_GA_AWDNOTFDATE N Date Award Notification Date. Can be 6, 8,

or 10 digit date.

COA_GA_GRNTPRDFROM N Date Grant Period From. Can be 6, 8, or

10 digit date.

COA_GA_GRNTPRDTO N Date Grant Period Through. Can be 6, 8,

or 10 digit date.

COA_GA_EXTDATE N Date Extended Date. Can be 6, 8, or 10

digit date.

COA_GA_PROJAMT N Currency 0.00 Projected Award Amount

COA_GA_PMTMTHD N 1 A (Advanced Payment) or R
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Table: tblAccountCode_N

Context Section: CONTEXT,COACODE,HEADER,HCOA

Field ID Req'd Field

Length

Default

Value

Notes

(Reimbursement)

COA_GA_CSP N Single 0.0000 Cost Sharing Percentage

COA_GA_ICR N Single 0.0000 Indirect Cost Rate

COA_GA_NRD N Date Next Reporting Date. Can be 6, 8, or

10 digit date.

COA_GA_LRD N Date Last Reporting Date. Can be 6, 8, or

10 digit date.

COA_GA_IAR N 1 Independent Audit Required? 0 =

No; 1 = Yes

COA_GA_GRNTSPNSR N 80 Grant Sponsor

COA_GA_GRNTID N 50 Grant ID

COA_GA_GRNTOFFICIAL N 80 Grant Official

COA_GA_POSITION N 40 Grant Official Job Position

COA_GA_VOICE N 25 Grantor Phone

COA_GA_FAX N 25 Grantor Fax

COA_GA_ADDR N 80 Grantor Address. Use "^" to separate

address lines.

COA_GA_CITY N 30 Grantor City

COA_GA_STATE N 6 Grantor State or Province

COA_GA_ZIP N 10 Grantor Postal Code

COA_GA_COUNTRY N 35 Grantor Country

COA_GA_EMAIL N 255 Email Address
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Table: tblAccountCode_N

Context Section: CONTEXT,COACODE,HEADER,HCOA

Field ID Req'd Field

Length

Default

Value

Notes

COA_GA_PGMOFFICIAL N 80 Program Official

COA_GA_CUSTID N User

Defined

Customer ID

Importing Fund Designation Codes

Note: Ensure the function FND is assigned to a segment by the Administrator on the

Organization>Organization Information>Segments tab.

The following table defines the field references to be used in the Fund Designation section of the

MasterGL.DEF file:

Table: tblFndDesginationCodes

Context Section: CONTEXT,COAFUNDDES,HEADER,HFND

Field ID Req'd Field

Length

Default

Value

Notes

FND_CODE Y 3 The Group Code (Reports>Assign Report

Groups) or Code (Maintain>Chart of

Accounts Codes) depending on how you

assigned designation codes.

FND_DESCRIPTION Y 45 The Group Title/Short Title

(Reports>Assign Report Groups) or

Description (Maintain>Chart of Accounts

Codes) depending on how you assigned

designation codes.

Importing Detail Lines or Required Account Assignments

The following table defines the field references to be used in the Detail Lines or Required Account

Assignments section of the MasterGL.DEF file:
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Table: tblAccountCodeDetail_0

Context Section: CONTEXT,COACODE,DETAIL,DCOA

Field ID Req'd Field

Length

Default

Value

Notes

COA_ASSIGN_NAME N 4 General Ledger Code; Available for all

balance sheet type general edger accounts

except for NAE account types. Use NBAL

or RES segments.

Importing Closing Account Assignments

The following table defines the field references to be used in the Closing Account Assignments section of

the MasterGL.DEF file:

Table: tblCloseAssign

Context Section: CONTEXT,CLOSEACCT,HEADER,HCLAC

Field ID Req'd Field

Length

Default

Value

Notes

CAA_FUND Y User

Defined

Fund to be closed. Required if

organization has fund segment.

CAA_GL Y User

Defined

GL Account to be closed.

REV, EXP, or IFT type only.

CAA_GL_

CLOSEINTO

Y User

Defined

GL Account to close into. Must be NAE

account type.

Importing Offset Account Assignments

Multicurrency Users

The OFFSET_CURRENCYTYPE field is only available if this module is installed and added to the

organization by the Administrator (Organization>Add a Module).

The following table defines the field references to be used in the Offset Account Assignments section of

the MasterGL.DEF file:
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Table: tblOffsetAssign

Context Section: CONTEXT,OFFSET,HEADER,HOFFST

Field ID Req'd Field

Length

Default

Value

Notes

OFFSET_TRANSID Y 3 Transaction Source Codes: APC, API,

ARB, ARC, CD, CR, or JV. See Table 1.

OFFSET_

TRIGGERFUNDID

Y User

Defined

Transaction entry (TE) fund. Required if

organization has Fund segment.

OFFSET_

TRIGGERGLID

Y User

Defined

TE GL Code

OFFSET_

CURRENCYTYPE

Y* 3 Active or inactive Currency code.

*Required for APC and ARC transaction

source codes.

OFFSET_OFFSETFUND Y User

Defined

Automatic Offset Fund. Required if

organization has Fund segment.

OFFSET_OFFSETGL Y User

Defined

Automatic Offset GL Code

OFFSET_TRIGGERIF Y* User

Defined

Interfund account used for TE fund.

*Required if TE fund is different than offset

fund.

OFFSET_OFFSETIF Y* User

Defined

Interfund account used for auto offset.

*Required if TE fund is different than auto

offset fund.

Importing Distribution Codes

Header

Distribution Codes can be imported into the system. If you are importing distribution codes that apply to

Accounting only, you must import using the DISTCODE_USE_IN_MODULE field and the value A. If the

distribution codes only apply to Payroll, you must import using the DISTCODE_USE_IN_MODULE field
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and the value P. Distribution codes that apply to both General Ledger and Payroll, can be imported into

the system using the DISTCODE_USE_IN_MODULE field and the value B. B (Both) is the default value.

Multicurrency Users

The DISTCODE_MCURRENCY field is only available if this module is installed and added to the

organization by the Administrator (Organization>Add a Module).

The following tables define the field references to be used in the Distribution Codes section of the

MasterGL.DEF file:

Table: tblDistCode

Context Section: CONTEXT,DISTCODE,HEADER,HDIST

Field ID Req'd Field

Length

Default

Value

Notes

DISTCODE_CODE Y User

Defined

Distribution Code

DISTCODE_

DESCRIPTION

Y User

Defined

Distribution Code Description

DISTCODE_STATUS Y 2 A A (Active), I (Inactive), or D

(Discontinued)

DISTCODE_

MCURRENCY

Y 3 Active or inactive Currency code.

DISTCODE_USE_IN_

MODULE

Y 2 B B (Both Accounting and Payroll), A

(Accounting only), or P (Payroll only)
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Detail

Table: tblDistCodeDetail

Context Section: CONTEXT,DISTCODE,DETAIL,DDIST

Field ID Req'd Field

Length

Default

Value

Notes

DISTDETAIL_

SEGMENT_

{SEGMENTNAME}

Y User

Defined

Replace {segment name} with the

actual segment name (one line for

each).

DISTDETAIL_UNITS N 8 0.0000 See note below.

DISTDETAIL_

PERCENTAGE

N Single 000.0000 Enter 5% as 05 or 5. See note below.

DISTDETAIL_AMOUNT N Currency 0.00 See note below.

Tips:
The DISTDETAIL_PERCENTAGE field must be REMed out (by starting the line with REM) if the

DISTDETAIL_UNITS field is used, and vice versa. Furthermore, combinations of units and amounts,

and combinations of percentages and amounts are allowed, but again, the *.DEF file must be modified

to "REM" out the line (percentage or units) that is not being used. Amounts are always applied first.

When importing header records for Distribution Codes, use the UPDATEITEM statement. However,

when importing detail field data, delete the master record and import the correct information, instead of

updating the existing records using the UPDATEITEM statement.

Importing Check Spoilage

The following table defines the field references to be used in the Check Spoilage section of the

MasterGL.DEF file:
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Table: tblCheckSpoilage

Context Section: CONTEXT,CHKSPOIL,HEADER,HCKSPOIL

Field ID Req'd Field

Length

Default

Value

Notes

CKSP_CASH_ACCT_

CODE

Y User

Defined

Must be General Ledger cash type

accounts.

CKSP_DATE Y Date Current

Date

Can be 6, 8, or 10 digit.

CKSP_DESCRIPTION Y 60 Description

CKSP_SINGLE Y 1 S = Single; R = Range

CKSP_CHECKNUM Y User

Defined

Spoiled Check Number

CKSP_STARTINGNUM Y Required if CKSP_SINGLE is R.

CKSP_ENDINGNUM Y Required if CKSP_SINGLE is R.

Importing Email Templates

The following tables define the field references to be used in the Email Templates section of the

MasterGL.DEF file:

Note: This information is only available for A/R Billing and Payroll users.

Table: tblEmailTemplate

Context Section: CONTEXT,EMAILTEMPLATE,HEADER,HEMAILTPLT

Field ID Req'd Field

Length

Default

Value

Notes

EMAIL_TYPE Y 50 Email Process Type: Invoice,

Statement, or Voucher

EMAIL_PROCESS_

TEMPLATE

Y 50 Default Email Process Template for the

Process Type. Recommend

completing a "<Default>" email
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Table: tblEmailTemplate

Context Section: CONTEXT,EMAILTEMPLATE,HEADER,HEMAILTPLT

Field ID Req'd Field

Length

Default

Value

Notes

process template for each email

process type imported.

EMAIL_FROM_

ADDRESS

Y 2000 From Email Address. Must be in

email format.

EMAIL_CC_

ADDRESS

N 2000 Cc Email Address. Must be in email

format.

EMAIL_BCC_

ADDRESS

N 2000 Bcc Email Address. Must be in email

format.

EMAIL_SUBJECT N 5000 Subject line for Email Type/Email

Process Template.

EMAIL_MESSAGE N 5000 Email Message for Email Type/Email

Process Template.

Importing Transaction Sessions

Note: When importing transactions, the system appends to current records. If you get a partial import,

you must delete the session before trying the import again.

Depending on the format of the data file, either use the MasterT1.DEF or MasterT3.DEF file for importing

Sessions and Transactions from other software programs. If the session, document, and transaction

information appears on every line, use T3. If the session, document, and transaction information appears

on separate lines in the data files, use T1.

You are required to define the same data in the import file as you would when entering transactions

directly into the system.

Note: Segments (such as Fund or GL) have to be set up in the system prior to Import. Segments are

established when the organization is created. As the Administrator, to view these settings use the

Organization>Organization Information form.
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Although you are not required to have a cash account included in a transaction entry line for CD or APC

documents for the Import process, a cash account is required by the system in the user interface.

Therefore, when you access imported CD or APC documents through the system and make changes,

the cash account on the check must match the cash account on the session. Otherwise, you cannot save

the changes.

Multicurrency Users

The SESSION_CURRENCY_TYPE and SESSION_RATE_TYPE fields are only available if this

module is installed and added to the organization by the Administrator (Organization>Add a Module).

The following table defines the field references to be used in the Sessions Header Information section of

the MasterT1.DEF and MasterT3.DEF files. The field IDs are used with both fixed-width and CSV

formatted data files.

Table: tblTESession

Context Section: CONTEXT,SESSION,HEADER,HSESSN

Field ID Req'd Field

Length

Default

Value

Notes

SESSION_

SESSIONNUMID

Y 14 Session ID

SESSION_STATUS Y 2 BP BP (Batch-To Post) or BS (Batch-To

Suspend)

SESSION_

CURRENCY_TYPE

Y 3 Active or inactive Currency code.

SESSION_RATE_

TYPE

Y 3 DSR (Daily Spot Rate) or MAR (Monthly

Average Rate)

SESSION_

DESCRIPTION

Y User

Defined

Required for Enter Encumbrances only.

SESSION_

SESSIONDATE

Y Date Current

Date

Can be 6, 8, or 10 digit date.

SESSION_

BUDGET_VERSION

N 60 Required if BD Transaction Source. If the

Budget Version, in the data file, does not

already exist in the system, it will be added
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Table: tblTESession

Context Section: CONTEXT,SESSION,HEADER,HSESSN

Field ID Req'd Field

Length

Default

Value

Notes

to the budget version ID list during the

Import process.

SESSION_

TRANSSOURCEID

Y 3 Transaction Source Codes: JV, CD, CR,

BD, ENC, ENL, API, APM, APC, ARB,

ARM, ARP, or ARC only. See Table 1.
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Importing Transaction Documents

The following section defines the field references used in the Document Information section of the *.DEF

file:

Table: tblTEDocument

Context Section: CONTEXT,TRANSENTRY,HEADER,HDOC

Field ID Req'd Field

Length

Default

Value

Notes

TEDOC_SESSION Y 14 Session ID

TEDOC_TRANSOURCE Y 3 Transaction Source Codes: API, APM,

APC, ARB, ARM, ARP, ARC, ENC,

ENL, JV, CD, CR, or BD. See Table 1.

TEDOC_DOCNUM Y User

Defined

Receipt, Check, Voucher, Document,

Invoice, or Credit Number

TEDOC_DESCRIPTION Y User

Defined

Transaction Description

TEDOC_PLAYER_ID Y User

Defined

Vendor or Customer ID. See note

below.

TEDOC_PLAYERTYPE N 1 V V for Vendor; C for Customer

TEDOC_1099TYPE Y 4 1099 Type ID, such as MISC, DIV, INT,

R, or W2G

TEDOC_ADDRESS_ID Y User

Defined

Vendor Check Address ID for API, APM,

APC, and CD.

TEDOC_DOCDATE Y Date Current

Date

Can be 6, 8, or 10 digit date.

TEDOC_DUEDATE Y Date Can be 6, 8, or 10 digit date. Valid for

API or ARB only.

TEDOC_MISCINFO N 25 Deposit valid for CR or ARC.

TEDOC_PAYMETHOD N 20 Payment Method for ARC, such as
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Table: tblTEDocument

Context Section: CONTEXT,TRANSENTRY,HEADER,HDOC

Field ID Req'd Field

Length

Default

Value

Notes

Cash, Check, Credit Card.

TEDOC_AR_CR_TYPE Y 25 Credit Type for ARM, such as Applied

Credit, Prepayment.

TEDOC_REVERSE N 5 NOREV Reverse, such as REV or NOREV.

TEDOC_REVERSE

EFFECTIVE DATE

Y Date Current

Date

Can be 6, 8, or 10 digit date. Valid for JV

- Reverse in Current Document only.

Note: The TEDOC_TRANSOURCE field is not used with the SampleT3ENL.DEF or SampleT3JV.DEF

files.

The TEDOC_PLAYER_ID field is required for transactions with a transaction source code of API, APM,

APC, ARB, ARM, ARC, ENC, or ENL. It is optional for CD or CR and is not used with JV or BD.

Importing Transaction Lines

The following section defines the field references used in the Transaction Information section of the *.DEF

file. You are required to define the same data in the import file as you would when entering transactions

directly into the system.

Table: tblTETrans

Context Section: CONTEXT,TRANSENTRY,DETAIL,DDOC

Field ID Req'd Field

Length

Default

Value

Notes

TETRANS_SESSION

NUMID

Y 14 Session ID

TETRANS_DOCNUM Y User

Defined

No Document Number

TETRANS_

DESCRIPTION

Y User

Defined

Document

Description

Transaction Description
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Table: tblTETrans

Context Section: CONTEXT,TRANSENTRY,DETAIL,DDOC

Field ID Req'd Field

Length

Default

Value

Notes

TETRANS_ENTRY_

TYPE

Y 2 N Normal (N), Beginning Balance (UO),

Adjust Opening Balance (AO), or End

of Year Adjustment (A).

TETRANS_

EFFECTIVEDATE

Y Date Document

Date

Can be 6, 8, or 10 digit date.

TETRANS_

SEGMENT_

{SEGMENT NAME}

Y User

Defined

Replace {segment name} with the

actual segment name (one line in

*.DEF file for each).

TETRANS_DEBIT Y Currency 0.00 Debit Amount

TETRANS_CREDIT Y Currency 0.00 Credit Amount

TETRANS_1099BOX Y 2 1099 Box Number. Only applies to CD,

API, APC, or APM, if Vendor is set to

1099. See Table 2.

TETRANS_MATCH_

DOCNUM

N User

Defined

N Original Invoice, Encumbrance, or

Receipt Number. Required for APM,

APC, ARM, ARC, and ENL. See Table

1.

TETRANS_MATCH_

TRANSSOURCE

Y Original Invoice. Required for ARC.

See Table 1.

TETRANS_CREDIT_

FLAG

Y 0.00 The way a credit (such as C, CR, or

Credit) is identified in the data.

TETRANS_DEBIT_

FLAG

Y 0.00 The way a debit (such as D, DR, or

Debit) is identified in the data.

TETRANS_AMOUNT_

INDICATOR

Y 0.00 Identifies the transaction flags, such as

Debit_Flag or Credit_Flag.

Note: You cannot use more than one entry type (TETRANS_ENTRY_TYPE) within a session.
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The Accounts Payable Module Data Fields
The following are specific data field tables used to import into the Accounts Payable module.

Importing Vendors

The following table defines the field references to be used in the Vendor Information section of the

MasterAP.DEF file:

Multicurrency Users

The VENDOR_CURRENCYTYPE field is only available if this module is installed and added to the

organization by the Administrator (Organization>Add a Module).

Table: tblAPVendor

Context Section: CONTEXT,VENDOR,HEADER,HVEND

Field ID Req'd Field

Length

Default

Value

Notes

VENDOR_ID Y User

Defined

Vendor ID

VENDOR_STATUS Y 1 A A (Active), I (Inactive), or D

(Discontinued)

VENDOR_NAME Y User

Defined

Vendor Name

VENDOR_

CURRENCYTYPE

N 3 Active or Inactive Currency code. If no

currency is being imported, remove this

field from the DEF file.

VENDOR_

FORCECURTYPE

N 1 0 Always Pay in Vendor's Currency. 0 =

No; 1 = Yes

VENDOR_USERID_GUID N See

Notes for

format.

The system user ID that is associated

with the vendor ID. A blank GUID

format: {00000000-0000-0000-0000-

000000000000}

VENDOR_CLASS N User

Defined

Optional Class Designation
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Table: tblAPVendor

Context Section: CONTEXT,VENDOR,HEADER,HVEND

Field ID Req'd Field

Length

Default

Value

Notes

VENDOR_TYPE N User

Defined

Optional Type Designation

VENDOR_ADDRESS Y* 80 Vendor Main Address. Use "^" to

separate address lines. *Required if

VENDOR_MISC1099 is Yes.

VENDOR_CITY Y* 30 Main Address City. *Required if

VENDOR_MISC1099 is Yes.

VENDOR_STATE Y* 6 Main Address State or Province.

Required if VENDOR_MISC1099 is

Yes.

VENDOR_ZIP Y* 10 Main Address Postal Code. Required if

VENDOR_MISC1099 is Yes.

VENDOR_COUNTRY N 35 Main Address Country

VENDOR_PHONE N 25 Main Address Phone

VENDOR_FAX N 25 Main Address Fax

VENDOR_FIRSTNAME N 30 Main Address Contact First Name

VENDOR_MIDDLENAME N 1 Main Address Contact Middle Initial

VENDOR_LASTNAME N 30 Main Address Contact Last Name

VENDOR_TITLE N 10 Main Address Contact Title

VENDOR_POSITION N 30 Main Address Contact Job Position

VENDOR_EMAIL N 50 Main Contact Email Address

VENDOR_

HOLDPAYMENTS

N 2 0 Hold payments? 0 = No; 1 = Yes

VENDOR_ N 2 0 Print separate checks for each invoice?
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Table: tblAPVendor

Context Section: CONTEXT,VENDOR,HEADER,HVEND

Field ID Req'd Field

Length

Default

Value

Notes

PRINTSEPCHECK 0 = No; 1 = Yes

VENDOR_

CHECKSTUBCOMMENT

N 30 Check Stub Comments

VENDOR_DISCOUNT1 N 50 00.0000 Enter 5% as 05 or 5.

VENDOR_

DAYSAVAILABLE1

N Integer 0 Days Available for 1st Discount

VENDOR_DISCOUNT2 N 50 00.0000 Enter 5% as 05 or 5.

VENDOR_

DAYSAVAILABLE2

N Integer 0 Days Available for 2nd Discount

VENDOR_NETDUEDAYS N Integer 30 Days until net amount due

VENDOR_GLCODE N User

Defined

Default GL (Expense) Account

VENDOR_DISTCODE N User

Defined

Default Distribution Code

VENDOR_MISC1099 N 1 0 Issue 1099 for this Vendor? 0 = No; 1 =

Yes

VENDOR_FOREIGNIND N 1 0 Foreign Address Indicator? 0 = No; 1 =

Yes

VENDOR_PROPNAME N* 30 Proprietor Name. *Required if

VENDOR_TAXIDTYPE is S.

VENDOR_TAXIDTYPE N 1 A F = FEIN; S = SSN; X = Foreign; A =

Applied For; or none. Required if

VENDOR_MISC1099 is Yes.

VENDOR_TAXID Y* 11 *Required if VENDOR_MISC1099 is

Yes and VENDOR_TAXIDTYPE is S or
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Table: tblAPVendor

Context Section: CONTEXT,VENDOR,HEADER,HVEND

Field ID Req'd Field

Length

Default

Value

Notes

F. Format:

xxx-xx-xxxx for SSN

xx-xxxxxxx for FEIN

VENDOR_

STATETAXWITHHELD

N 1 State Withholding Collected? 0 = No; 1

= Yes

VENDOR_1099STATE N* 2 State Abbreviation. *Required if

VENDOR_STATETAXWITHHELD is

Yes.

VENDOR_STATETAXID N* 11 State Tax ID. *Required if VENDOR_

STATETAXWITHHELD is Yes.

xxx-xx-xxxx for SSN

VENDOR_

1099TYPEDEFAULT

N 4 Default Form Type

VENDOR_

MISC1099BOXNUM

N 8 N/A Default Box Number. See Table 2.

VENDOR_

NAMECONTROL

N 4 Electronic Filing Name Control. If the

currency is USD and the Issue 1099 for

this Vendor check box is selected, this

field is required.

VENDOR_NOTES N Notes

VENDOR_POSAMEAS N Integer Main None = 0, Main = 1, or Check = 3

VENDOR_POADDRESS N 80 Purchase Order Address. Use "^" to

separate address lines.

VENDOR_POCITY N 30 Purchase Order Address City

VENDOR_POSTATE N 6 Purchase Order Address State or

Province
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Table: tblAPVendor

Context Section: CONTEXT,VENDOR,HEADER,HVEND

Field ID Req'd Field

Length

Default

Value

Notes

VENDOR_POZIP N 10 Purchase Order Address Postal Code

VENDOR_POCOUNTRY N 35 Purchase Order Address Country

VENDOR_POPHONE N 25 Purchase Order Address Phone

VENDOR_POFAX N 25 Purchase Order Address Fax

VENDOR_POFIRSTNAME N 30 Purchase Order Address Contact First

Name

VENDOR_

POMIDDLENAME

N 1 Purchase Order Address Contact

Middle Initial

VENDOR_POLASTNAME N 30 Purchase Order Address Contact Last

Name

VENDOR_POTITLE N 10 Purchase Order Address Contact Title

VENDOR_POPOSITION N 30 Purchase Order Address Contact Job

Position

VENDOR_POEMAIL N 50 Purchase Order Contact Email Address

VENDOR_ACCOUNT N 30 Account Number assigned by vendor.

VENDOR_EPAYMENTS N 2 Activate Electronic Payments?

0 = No; 1 = Yes

VENDOR_ROUTINGNUM Y 9 Vendor's 9 digit Bank Routing Number.

Required if VENDOR_ EPAYMENTS is

Yes.

VENDOR_ACCOUNTNUM Y 17 Vendor's Checking or Loan bank

account number. Required if VENDOR_

EPAYMENTS is Yes.

VENDOR_ACCOUNTTYPE Y 2 22 Electronic Payment Type: 22 for
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Table: tblAPVendor

Context Section: CONTEXT,VENDOR,HEADER,HVEND

Field ID Req'd Field

Length

Default

Value

Notes

Checking and 52 for Loan. Required if

VENDOR_ EPAYMENTS = Yes and if

EFT for A/P is installed.

VENDOR_PRENOTE Y 2 Send Prenote for this vendor?

No or Yes. Case Sensitive. Required if

VENDOR_ EPAYMENTS is Yes.

VENDOR_

PERSONALACCT

N 1 0 0 = No; 1 = Yes

VENDOR_EFTEMAIL Y 50 Vendor Email Address to send the

payment notification. Required if

VENDOR_ NOEMAIL is not selected.

VENDOR_NOEMAIL N 2 Do not send payment notification

email? 0 = No; 1 = Yes. Therefore if "1"

is selected, no notification will be

sent.Not available if VENDOR_

EPAYMENTS = No.
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Importing Detail Lines or 1099 Adjustments

The following table defines field references used in the Accounts Payable Detail Lines or 1099

Adjustments section of the MasterAP.DEF file:

Table: tbl1099Adjustment

Context Section: CONTEXT,VENDOR,DETAIL,DVEND

Field ID Req'd Field

Length

Default

Value

Notes

VENDOR_YEAR Y 4 1099 Year Format: xxxx

VENDOR_1099TYPEID Y 4 1099 Type ID, such as MISC, DIV, INT,

R, or W2G

VENDOR_BOXNUMID Y 8 N/A 1099 Box Number. See Table 2.

VENDOR_AMOUNT Y Currency 0.00 1099 Amount

Tips:
Vendor 1099 adjustments can only be imported with a full vendor record. Also note that 1099 fields are

only required for adjustments being imported.

When importing header records for 1099 Adjustments, use the UPDATEITEM statement. However,

when importing detail field data, delete the master record and import the correct information, instead of

updating the existing records using the UPDATEITEM statement.

Importing Vendors Check Address

Multicurrency Users

The VENDOR_CURRENCYTYPE field is only available if this module is installed and added to the

organization by the Administrator (Organization>Add a Module).

The following table defines the field references to be used in the Vendor Information section of the

MasterAP.DEF file:
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Table: tblAddressCodes

Context Section: CONTEXT,VENDADDR_CODES,HEADER,HVENDCHCKADDR

Field ID Req'd Field

Length

Default

Value

Notes

AC_PARN_ID Y User

Defined

Same as Vendor ID.

AC_ADDRESS_ID Y User

Defined

Check Address Code

AC_STATUS Y 1 A A (Active), I (Inactive), or D

(Discontinued)

AC_SAME_AS Y Interger Main None = 0; Main = 1, or PO = 2

AC_PREFERRED Y 3 Yes

AC_DESCRIPTION Y User

Defined

Check Address Code Description

AC_ADDRESS N 80 Check Address. Use "^" to separate

address lines.

AC_CITY N 30 Check Address City

AC_STATE N 6 Check Address State or Province

AC_ZIP N 10 Check Address Postal Code

AC_COUNTRY N 35 Check Address Country

AC_CONTACT_PHONE N 25 Check Address Phone

AC_CONTACT_FAX N 25 Check Address Fax

AC_CONTACT_TITLE N 10 Check Address Contact Title

AC_CONTACT_

FIRST_NAME

N 30 Check Address Contact First Name

AC_CONTACT_

MIDDLE_INITIAL

N 1 Check Address Contact Middle Initial
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Table: tblAddressCodes

Context Section: CONTEXT,VENDADDR_CODES,HEADER,HVENDCHCKADDR

Field ID Req'd Field

Length

Default

Value

Notes

AC_CONTACT_

LAST_NAME

N 30 Check Address Contact Last Name

AC_CONTACT_

POSITION

N 30 Check Address Contact Job Position

AC_CONTACT_EMAIL N 50 Check Contact Email Address

Tip: Vendor Check Address can only be imported with a full vendor record.

The Accounts Receivable Module Data Fields
The following are specific data field tables used to import into the Accounts Receivable module.

Importing Charge Codes

Multicurrency Users

The CHARGECODE_CURRENCY field is only available if this module is installed and added to the

organization by the Administrator (Organization>Add a Module).

The following tables define field references used in the Charge Codes section of the MasterAB.DEF file:

Header

Table: tblARChargeCode

Context Section: CONTEXT,CHARGECODE,HEADER,HCHCOD

Field ID Req'd Field

Length

Default

Value

Notes

CHARGECODE_ID Y User

Defined

Charge Code

CHARGECODE_

STATUS

Y 1 A A (Active), I (Inactive), or D

(Discontinued)
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Table: tblARChargeCode

Context Section: CONTEXT,CHARGECODE,HEADER,HCHCOD

Field ID Req'd Field

Length

Default

Value

Notes

CHARGECODE_

DESCRIPTION

Y User

Defined

Code Description

CHARGECODE_

CURRENCY

N 3 functional

currency

Active or inactive Currency code.

CHARGECODE_

REVACCT

Y User

Defined

GL (Revenue) Account

CHARGECODE_

DISTCODE

Y 12 Distribution Code

CHARGECODE_

TYPE

N User

Defined

Optional Charge Code Designation

CHARGECODE_

TAXABLE

N 1 0 0 = No; 1 = Yes

CHARGECODE_

FREIGHT

N 1 0 0 = No; 1 = Yes

CHARGECODE_

CCTYPE

N 1 N N (Non-Inventory Related)

CHARGECODE_

COGSACCT

N 5 Cost of Goods Sold General Ledger

Account.

CHARGECODE_

ITEMCODE

N 12 Related Item Code.

CHARGECODE_

CALCMETHOD

Y 2 FA, FP, VC, AV, PA, or VP. See Table 3.

CHARGECODE_

VALUE

N Currency 0.00 Required for FA and FP. See Table 3.

CHARGECODE_ N 18 0.00 Required for VP and AV. See Table 3.
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Table: tblARChargeCode

Context Section: CONTEXT,CHARGECODE,HEADER,HCHCOD

Field ID Req'd Field

Length

Default

Value

Notes

MAXBILLABLE

CHARGECODE_

PERC

N 8 Required for PA

CHARGECODE_

PA_PERIOD

N 25 Required for PA

Detail

Table: tblARChargeCodeCalculation

Context Section: CONTEXT,CHARGECODE,DETAIL,DCHCOD

Field ID Req'd Field

Length

Default

Value

Notes

CCPL_CHARGECODE Y User

Defined

Charge Code

CCPL_LINENUM N Integer Order line items are listed.

CCPL_FIXEDCHARGE Y Currency 0.00 Required for VP. See Table 3.

CCPL_UNITPRICE Y Currency 0.00 Required for VP and AV. See Table 3.

CCPL_MAXUNITS Y 4 0.00 Required for VP and AV. See Table 3.
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Importing One Time Charges

The following tables define field references used in the One Time Charges section of the MasterAB.DEF

file:

Header

Table:

Context Section: CONTEXT,ONETIMECHARGES,HEADER,HOTC

Field ID Req'd Field

Length

Default

Value

Notes

OTC_BILLINGGRPID Y User

Defined

Billing Group

OTC_CUSTID Y User

Defined

Customer ID

Detail

Table:

Context Section: CONTEXT,ONETIMECHARGES,DETAIL,DOTC

Field ID Req'd Field

Length

Default

Value

Notes

OTC_CI_

PERSISTCHARGE

N 1 No Recurring? 0 = No; 1 = Yes

OTC_CI_

CHARGECODE

Y User

Defined

Charge Code

OTC_CI_

DESCRIPTION

Y 255 Charge

Code

Description

Description

OTC_CI_

CHARGEDATE

Y Date Charge Date. Can be 6, 8, or 10

digit.

OTC_CI_DISTCODE Y User Distribution Code
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Table:

Context Section: CONTEXT,ONETIMECHARGES,DETAIL,DOTC

Field ID Req'd Field

Length

Default

Value

Notes

Defined

OTC_CI_

FIXEDCHARGE

N Currency 0.00 Required for VC

OTC_CI_QUANTITY N Single 0.00 Required for AV, FP, VC, or VP

OTC_CI_UNITPRICE N Currency 0.00 Required for VC

Customers

Customer Header

Multicurrency Users

The CUSTOMER_CURRENCYTYPE field is only available if this module is installed and added to the

organization by the Administrator (Organization>Add a Module).

Note: If you want to include default shipping address code information, first run the import with new

customer information, but do not include the CUSTOMER_DEFSHIPADDRCODEID field. Then, run

import a second time including the CUSTOMER_DEFSHIPADDRCODEID field. You must do this

because the shipping address <billing> is not created until the customer is imported and saved.

The following table defines the field references to be used in the Customers section of the MasterAR.DEF

file:
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Table: tblARCustomer

Context Section: CONTEXT,CUSTOMER,HEADER,HCUST

Field ID Req'd Field

Length

Default

Value

Notes

CUSTOMER_ID Y User

Defined

Customer ID

CUSTOMER_STATUS Y 1 A A (Active), I (Inactive), or D

(Discontinued)

CUSTOMER_NAME Y User

Defined

Customer Name

CUSTOMER_

CURRENCYTYPE

N 3 functional

currency

Active or Inactive Currency code.

CUSTOMER_

FORCECURTYPE

N 1 0 Always Receive in Customer's

Currency? 0 = No; 1 = Yes

CUSTOMER_

CASHCUSTOMER

N 1 0 Cash Only? 0 = No; 1 = Yes

CUSTOMER_CLASS N User

Defined

Optional Class Designation

CUSTOMER_TYPE N User

Defined

Optional Type Designation

CUSTOMER_ADDRESS N 80 Customer Billing Address. Use "^"

to separate address lines.

CUSTOMER_

BILLINGCITY

N 30 Billing Address City

CUSTOMER_

BILLINGSTATE

N 6 Billing Address State or Province

CUSTOMER_BILLINGZIP N 10 Billing Address Postal Code

CUSTOMER_

BILLINGCOUNTRY

N 35 Billing Address Country
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Table: tblARCustomer

Context Section: CONTEXT,CUSTOMER,HEADER,HCUST

Field ID Req'd Field

Length

Default

Value

Notes

CUSTOMER_

BILLINGPHONE

N 25 Billing Address Phone

CUSTOMER_BILLINGFAX N 25 Billing Address Fax

CUSTOMER_

BILLINGFIRSTNAME

N 30 Billing Address Contact First Name

CUSTOMER_

BILLINGMIDDLENAME

N 1 Billing Address Contact Middle

Initial

CUSTOMER_

BILLINGLASTNAME

N 30 Billing Address Contact Last Name

CUSTOMER_

BILLINGTITLE

N 10 Billing Address Contact Title

CUSTOMER_

BILLINGPOSITION

N 30 Billing Address Contact Job

Position

CUSTOMER_

BILLINGEMAIL

N 50 Billing Contact Email Address

CUSTOMER_

CREDITSTOP

Y 2 0 Credit hold? 0 = No; 1 = Yes

CUSTOMER_

CUSTOMERCOMMENT

Y 30 Billing Comments

CUSTOMER_

NETDUEDAYS

N Integer 30 Days Until Net Amount Due

CUSTOMER_DISCOUNT1 N 8 00.0000% First Discount. Must be in decimal

format, e.g., .05 = 5% or .025 =

2.5%

CUSTOMER_ N 3 0 First Discount Days Available
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Table: tblARCustomer

Context Section: CONTEXT,CUSTOMER,HEADER,HCUST

Field ID Req'd Field

Length

Default

Value

Notes

DAYSAVAILABLE1

CUSTOMER_DISCOUNT2 N 8 00.0000% Second Discount. Must be in

decimal format, e.g., .05 = 5% or

.025 = 2.5%

CUSTOMER_

DAYSAVAILABLE2

N 3 0 Second Discount Days Available

CUSTOMER_

DEFREVACCT

N User

Defined

Default GL (Revenue) Account

CUSTOMER_DISTCODE N User

Defined

Default Distribution Code

CUSTOMER_

DISCACCT

N 5 Discount General Ledger Account

CUSTOMER_WEBSITE N 50 Customer Website

CUSTOMER_

RESALETAXID

N 11 Customer Resale Tax ID

CUSTOMER_NOTES N Notes

CUSTOMER_

SERVICESAMEAS

N Integer Billing None = 0; Billing = 1

CUSTOMER_

SERVICEADDRESS

N 80 Service Address. Use "^" to

separate address lines.

CUSTOMER_

SERVICECITY

N 30 Service Address City

CUSTOMER_

SERVICESTATE

N 6 Service Address State or Province
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Table: tblARCustomer

Context Section: CONTEXT,CUSTOMER,HEADER,HCUST

Field ID Req'd Field

Length

Default

Value

Notes

CUSTOMER_SERVICEZIP N 10 Service Address Postal Code

CUSTOMER_

SERVICECOUNTRY

N 35 Service Address Country

CUSTOMER_

SERVICEPHONE

N 25 Service Address Phone

CUSTOMER_

SERVICEFAX

N 25 Service Address Fax

CUSTOMER_

SERVICEFIRSTNAME

N 30 Service Address Contact First

Name

CUSTOMER_

SERVICEMIDDLENAME

N 1 Service Address Contact Middle

Initial

CUSTOMER_

SERVICELASTNAME

N 30 Service Address Contact Last

Name

CUSTOMER_

SERVICETITLE

N 10 Service Address Contact Title

CUSTOMER_

SERVICEPOSITION

N 30 Service Address Contact Job

Position

CUSTOMER_

SERVICEEMAIL

N 50 Service Contact Email Address

CUSTOMER_

TAXABLE

N 1 0 Taxable? 0 = No; 1 = Yes

CUSTOMER_

FINCHARGES

N 1 0 Apply Finance Charges? 0 = No; 1

= Yes

CUSTOMER_

DEFSHIPADDRCODEID

N 15 Default Shipping Address.

Required if a Taxable Customer.
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Table: tblARCustomer

Context Section: CONTEXT,CUSTOMER,HEADER,HCUST

Field ID Req'd Field

Length

Default

Value

Notes

CUSTOMER_PAPER N 1 1 Print Paper Invoice? 0 = No; 1 =

Yes

CUSTOMER_EMAIL N 1 0 Email Invoice? 0 = No; 1 = Yes

CUSTOMER_EMAILADDR Y* 2000 0 Invoice Email Address. *Required

if CUSTOMER_EMAIL is Yes.

Must be in email format.

CUSTOMER_

EMAILTEMPLATE

Y 50 <Default> Invoice Process Template.

Required if CUSTOMER_EMAIL is

Yes; otherwise <Default> displays.

CUSTOMER_STMTEMAIL N 1 0 Email Statement? 0 = No; 1 = Yes

CUSTOMER_

STMTPAPER

N 1 1 Print Paper Statement? 0 = No; 1 =

Yes

CUSTOMER_

STMTEMAILADDR

Y* 2000 0 Statement Email Address.

*Required if CUSTOMER_

STMTEMAIL is Yes. Must be in

email format.

CUSTOMER_

STMTEMAILTEMPLATE

Y 50 <Default> Statement Process Template.

Required if CUSTOMER_

STMTEMAIL is Yes; otherwise

<Default> displays.
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Customer Ship Address Header

Table: tblARCustomerShipAddress

Context Section: CONTEXT,CUSTOMERSHIPADDR,HEADER,HCUSTSHIPADDR

Field ID Req'd Field Length Default

Value

Notes

CUSTOMER_

SHIPCUSTID

Y User Defined Shipping Address Customer ID

CUSTOMER_

SHIPADDRESS_ID

N User Defined Shipping Address Code

CUSTOMER_

SHIPADDRESS

N 80 Shipping Address. Use "^" to

separate address lines.

CUSTOMER_

SHIPCITY

N 30 Shipping City

CUSTOMER_

SHIPSTATE

N 6 Shipping State or Province

CUSTOMER_

SHIPZIP

N 10 Shipping Postal Code

CUSTOMER_

SHIPCOUNTRY

N 35 Shipping Address Country

CUSTOMER_

SHIPTITLE

N 10 Shipping Address Contact Title

CUSTOMER_

SHIPFIRSTNAME

N 30 Shipping Address Contact First

Name

CUSTOMER_

SHIPMIDDLE_

INITIAL

N 1 Shipping Address Contact

Middle Initial

CUSTOMER_

SHIPLAST_NAME

N 30 Shipping Address Contact Last

Name
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Table: tblARCustomerShipAddress

Context Section: CONTEXT,CUSTOMERSHIPADDR,HEADER,HCUSTSHIPADDR

Field ID Req'd Field Length Default

Value

Notes

CUSTOMER_

SHIPPOSITION

N 30 Shipping Address Contact Job

Position

CUSTOMER_

SHIPPHONE

N 30 Shipping Address Phone

CUSTOMER_

SHIPEMAIL

N 50 Shipping Address Contact Email

Address

CUSTOMER_

SHIPFAX

N 30 Shipping Address Fax

CUSTOMER_

SHIPTAX_CODE

Y 15 Shipping Sales Tax Code

The Bank Reconciliation Module Data Fields
The following are specific data field tables used to import data into the Bank Reconciliation module:

Importing Bank Reconciliation Information

The following table defines the field references to be used in the MasterBK.DEF file:

Table: tblDLCash & tblBKDeposits

Context Section: CONTEXT,BKREC,HEADER,HBKREC

Field ID Req'd Field

Length

Default

Value

Notes

BKREC_CHECK_FLAG Y Required if reconciling checks.

Exact word in description field.

BKREC_DEPOSIT_

FLAG

Y Required if reconciling deposits.

Exact word in description field.

BKREC_CASH_ACCT Y User GL CSH Account Number
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Table: tblDLCash & tblBKDeposits

Context Section: CONTEXT,BKREC,HEADER,HBKREC

Field ID Req'd Field

Length

Default

Value

Notes

Defined

BKREC_REC_DATE Y Date Reconciliation Date. Can be 6,

8, or 10 digit date.

BKREC_DOC_NUM Y Check, Deposit, or Document

Number

BKREC_AMOUNT Y Currency 0.00 Check, Deposit, or Document

Amount. Default value must be

0.00. Decimal places must be 0.

Indicate sign: + Deposit, or -

Check.

BKREC_DESC N User

Defined

Check or Document Description

Note: You must enter a negative amount for checks.

Tip: If your Default Values "Check" and "Deposit" are located in the same column, you should use the

value of zero in the CSV string definition. For example, BKREC_CHECK_FLAG,0,CHECK. BKREC_

DEPOSIT_FLAG,0,DEPOSIT. The 0 tells the system to look for the Default Values "CHECK" and

"DEPOSIT" anywhere on the row.

If your default values "CK" and "DP" are located in two separate columns (2nd and 4th), you should use

the two values in the CSV string definition. For example BKREC_CHECK_FLAG,2,CK. BKREC_

DEPOSIT_FLAG,4,DP. The 2 and 4 tells the system to look for the "CK" in the 2nd column and the "DP"

in the 4th column.

If you choose to use this method, you must also tell the system which column the combined data is in

using the BKREC_DESC field ID. For example, if the combined data resides in column 9, BKREC_

DESC should be mapped to column 9, as in, “BKREC_DESC, 9”. Otherwise, errors will occur.
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The Fixed Assets Module Data Fields
Import Designation Codes and Asset Types first, and then Assets, since types and codes must exist

before assets can be imported.

All imported asset information should be verified prior to processing depreciation of disposals in the

system.

Fixed asset imports do not affect the General Ledger. The asset, accumulated depreciation, and

depreciation expense account balances must be recorded.

Importing Asset Types

The following table defines the field references used in the Asset Types section of the MasterFA.DEF

file:

Table: tblFAType

Context Section: CONTEXT,FATYPE,HEADER,HASSETTYPE

Field ID Req'd Field

Length

Default

Value

Notes

FATM_TYPEID Y User

Defined

Asset Type ID

FATM_STATUS Y 1 A (Active), I (Inactive), or D

(Discontinued)

FATM_DESCRIP Y User

Defined

Asset Type Description

FATM_DEPRCODE Y User

Defined

Depreciation Methods: SL, SYD, DB150,

DB200, No, or <Unique Custom Code>.

See Table 4.

FATM_SW_

DEPRCODE

N User

Defined

Switch Depreciation Code (SL). Not valid

if FATM_DEPRCODE is SL. See Table

4.

FATM_DISTCODE Y User

Defined

Default Distribution Code

FATM_EXPCODE Y User Default GL Depreciation Expense Type



The Fixed Assets Module Data Fields

Table: tblFAType

Context Section: CONTEXT,FATYPE,HEADER,HASSETTYPE

Field ID Req'd Field

Length

Default

Value

Notes

Defined Account. Must be set up using

Maintain>Chart of Accounts Codes.

FATM_ADCODE Y User

Defined

Default Accumulated Depreciation GL—

FAO-Type Account. Must be set up using

Maintain>Chart of Accounts Codes.

FATM_ASSETCODE Y User

Defined

Default Asset GL—FAO-Type Account.

Must be set up using Maintain>Chart of

Accounts Codes.

Importing Designation Codes

The following table defines the field references to be used in the Designation Codes section of the

MasterFA.DEF file:

Table: tblFARespCode, tblFAAcqCode ,tblFALocCode, or tblFAValCode

Context Section: CONTEXT,DESGCODES,HEADER,HDESIG

Field ID Req'd Field

Length

Default

Value

Notes

MTNDSG_CODETYPE Y 1 (A) Acquisition, (L) Location, (R)

Responsibility, or (V) Valuation

MTNDSG_CODEID Y User

Defined

Code Name

MTNDSG_STATUS Y 1 A A (Active), I (Inactive), or D (Discontinued)

MTNDSG_DESCRIP Y User

Defined

Code Description

Importing Assets

The following table defines the field references to be used in the Assets section of the MasterFA.DEF file:
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Table: tblFACode

Context Section: CONTEXT,ASSETS,HEADER,HASSET

Field ID Req'd Field

Length

Default

Value

Notes

ASSET_ID Y User

Defined

Asset ID

ASSET_STATUS Y 1 A A (Active), I (Inactive), or D

(Discontinued/Disposed)

ASSET_DESCRIPTION Y User

Defined

Asset Description

ASSET_CATEGORY Y User

Defined

Category

ASSET_TAG N 30 Asset Tag

ASSET_ORGASSETID N User

Defined

Original Asset ID

ASSET_TAXABLE N 1 0 0 = No; 1 = Yes

ASSET_ACQCODE N User

Defined

Acquisition Code

ASSET_RESCODE N User

Defined

Responsibility Code

ASSET_VALCODE N User

Defined

Valuation Code

ASSET_LOCCODE N User

Defined

Location Code

ASSET_TYPE_ID Y User

Defined

Asset Type ID

ASSET_COST Y Currency 0.00 Cost or Basis Amount

ASSET_SALVAGE Y Currency 0.00 Salvage Value
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Table: tblFACode

Context Section: CONTEXT,ASSETS,HEADER,HASSET

Field ID Req'd Field

Length

Default

Value

Notes

ASSET_

BEGDEPRDATE

Y Date Current

Date

Begin Depreciation Date. Can be 6, 8,

or 10 digit date.

ASSET_

LASTDEPRDATE

N Date Last Depreciation Date. Can be 6, 8, or

10 digit date.

ASSET_

ACCMDEPRAMT

Y Currency 0.00 Accumulation Depreciation Amount.

Required if Last Depreciation Date is

completed.

ASSET_MONTHSDEPR Y Integer 0 Months Depreciated. Required if Last

Depreciation Date is completed.

ASSET_MAINTDATE N Date Can be 6, 8, or 10 digit date.

ASSET_WARRANTY N 60 Warranty

ASSET_MODEL N 40 Manufacturer/Model Number

ASSET_SERIAL N 40 Serial Number

ASSET_PAYEE N 50 Payee or Vendor ID

ASSET_DOCNUM N User

Defined

Check or Invoice Number

ASSET_ACQDATE N Date Can be 6, 8, or 10 digit date.

ASSET_PONUM N User

Defined

Purchase Order Number

ASSET_CODE N User

Defined

Asset Code

ASSET_LIFE Y Integer Life in Months

ASSET_

REPLACECOST

N Currency 0.00 Replacement Cost
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Table: tblFACode

Context Section: CONTEXT,ASSETS,HEADER,HASSET

Field ID Req'd Field

Length

Default

Value

Notes

ASSET_ZEROBV N 1 0 0 = No; 1 = Yes

If the ASSET_ZEROBV is set to 1 then

the following fields will default to zero or

blank regardless if values have been

designated in the Def file: ASSET_

COST, ASSET_SALVAGE, ASSET_

BEGDEPRDATE, ASSET_

LASTDEPRDATE, ASSET_

ACCMDEPRAMT, and ASSET_

MONTHSDEPR.

ASSET_NOTES N Notes
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Importing Custom Depreciation Codes

The following tables define the field references to be used in the Depreciation Codes section of the

MasterFA.DEF file:

Header

Table: tblFADeprCode

Context Section: CONTEXT,FADEPR,HEADER,HDEPRCODE

Field ID Req'd Field

Length

Default

Value

Notes

DEPR_CODEID Y User

Defined

Custom Depreciation Code

DEPR_STATUS Y 1 A A (Active), I (Inactive), or D

(Discontinued)

DEPR_DESCRIP Y User

Defined

Code Description

DEPR_METHOD Y 2 FA FA, PD, PN, TD, or TN. See Table 3.

DEPR_FAMOUNT Y Currency 0.00 Required for FA. See Table 3.

DEPR_PERCENT Y Percent 000.0000 Required for PD or PN. Enter 5% as

05 or 5. See Table 3.
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Detail

Table: tblFADeprCodeDetail

Context Section: CONTEXT,FADEPR,DETAIL,DDEPRCODE

Field ID Req'd Field

Length

Default

Value

Notes

DEPR_DET_YEAR Y Integer Number of years into

depreciation; not calendar year.

Required for TN or TD.

DEPR_DET_PERC Y Percent 000.0000 Required for TN or TD. Enter 5%

as 05 or 5.

DEPR_DET_NOTE N 30 Notes

The Multicurrency Module Data Fields
The following are specific data field tables used to import data into the Multicurrency module:

Importing Exchange Rates

The following tables define field references used in the Exchange Rate Header Information section of the

MasterMCRATE.DEF file:

Table: tblMCExchangeRates

Context Section: CONTEXT,MCRATE,HEADER,HEXR

Field ID Req'd Field

Length

Default

Value

Notes

EXR_RATE_TYPE Y 3 DSR (Daily Spot Rate) or MAR (Monthly

Average Rate)

EXR_CURRENCY Y 3 Active or inactive Currency code.

EXR_ACTIVE_DATE Y Date Active Date. Can be 6, 8, or 10 digit

date.

EXR_EXCHANGE_

RATE

Y 8 0.0000000 Currency Exchange Rate
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Table: tblMCExchangeRates

Context Section: CONTEXT,MCRATE,HEADER,HEXR

Field ID Req'd Field

Length

Default

Value

Notes

EXR_EXPIRATION_

DATE

Y Date Expiration Date. Can be 6, 8, or 10 digit

date.

EXR_SOURCE N 35 Exchange Rate Source

Tips:
You cannot import the functional currency.

If you attempt to import a date that does not follow the format outlined in the DEF file or the system's

date settings, the system defaults to today's date. This could cause exchange date overwrites.

You should limit the EXR_EXCHANGE_RATE field to six digits before and 7 digits after the decimal.

There are no fixed width files for exchange rates.

The Payroll Module Data Fields
The following are specific data field tables used to import data into the Payroll module:

Importing Processing Groups

The following table shows examples of data fields used in the Processing Groups section of the

MasterPR.DEF file:

Table: tblPRProcessGrp

Context Section: CONTEXT,PGRPCODE,HEADER,HPRCGRP

Field ID Req'd Field

Length

Default

Value

Notes

PR_MTN_PG_CODE Y User

Defined

Processing Group Code

PR_MTN_PG_STATUS N 1 A A (Active), I (Inactive), or D

(Discontinued)
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Table: tblPRProcessGrp

Context Section: CONTEXT,PGRPCODE,HEADER,HPRCGRP

Field ID Req'd Field

Length

Default

Value

Notes

PR_MTN_PG_TITLE Y User

Defined

Processing Group Title

PR_MTN_PG_

PAYCYCLE

Y 1 W (Weekly), B (Biweekly), S

(Semimonthly), and M (Monthly)

PR_MTN_PG_YEAR Y 4 Processing Group Pay Schedule Tax

Year

PR_MTN_PG_

FIRSTPAYDATE

Y Date Can be 6, 8, or 10 digit.

PR_MTN_PG_

ENDPERIODDATE

Y Date Can be 6, 8, or 10 digit.

Importing Earning Codes

The following table shows examples of data fields used in the Earning Codes section of the

MasterPR.DEF file:

Table: tblPREarnCode

Context Section: CONTEXT,EARNINGCODE,HEADER,HEARN

Field ID Req'd Field

Length

Default

Value

Notes

PREC_CODE Y User

Defined

Earning Code ID

PREC_STATUS N 1 A A (Active), I (Inactive), or D

(Discontinued)

PREC_TITLE Y User

Defined

Earning Code Title

PREC_EXPENSE_ Y User Must be set up using Maintain>Chart of
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Table: tblPREarnCode

Context Section: CONTEXT,EARNINGCODE,HEADER,HEARN

Field ID Req'd Field

Length

Default

Value

Notes

ACCOUNT Defined Accounts Codes.

PREC_TRACK_

LABOR_

HRS

N 1 1 0 = No; 1 = Yes

PREC_CONT_NET_

PAY_

ONLY

N 1 0 0 = No; 1 = Yes

PREC_W2_BOX_NUM N 2 W-2 Box Number, if any

PREC_W2_BOX_

CODE

N 5 W-2 Box Code, if any

PREC_CALC_

METHOD

Y 2 ER Valid Calculation Methods: ER, RM,

FH, FA, RT, and AT. See Table 3.

PREC_AMOUNT Y Currency 0.0000 Required if calculation method of FH or

FA.

PREC_RATE Y 5 0.0000 Required if calculation method of RT or

RM.

PREC_FED_FIT N 2 0 = No; 1 = Yes

PREC_FED_SOCIAL_

SEC

N 2 0 = No; 1 = Yes

PREC_FED_

MEDICARE

N 2 0 = No; 1 = Yes

PREC_FED_FUTA N 2 0 = No; 1 = Yes

PREC_STATE_SWT N 2 0 = No; 1 = Yes

PREC_STATE_SUTA N 2 0 = No; 1 = Yes
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Table: tblPREarnCode

Context Section: CONTEXT,EARNINGCODE,HEADER,HEARN

Field ID Req'd Field

Length

Default

Value

Notes

PREC_LOCAL_LWT N 2 0 = No; 1 = Yes

PREC_LOCAL_

EMPLOYER

N 2 0 = No; 1 = Yes

Importing Benefit Codes

The following tables show examples of data fields used in the Benefit Codes section of the

MasterPR.DEF file:

Header

Table: tblPRBeneCode

Context Section: CONTEXT,BENEFITCODE,HEADER,HBENE

Field ID Req'd Field

Length

Default

Value

Notes

PR_BENE_CODE Y User

Defined

Benefit Code ID

PR_BENE_STATUS N 1 A A (Active), I (Inactive), or D

(Discontinued)

PR_BENE_TITLE Y User

Defined

Benefit Code Title

PR_BENE_GLEXP_

CODE

Y User

Defined

Must be set up using Maintain>Chart of

Accounts Codes.

PR_BENE_GLLIAB_

CODE

Y User

Defined

Must be set up using Maintain>Chart of

Accounts Codes.

PR_BENE_

CHECKSTUB

N 1 1 0 = No; 1 = Yes
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Table: tblPRBeneCode

Context Section: CONTEXT,BENEFITCODE,HEADER,HBENE

Field ID Req'd Field

Length

Default

Value

Notes

PR_BENE_W2_BOX N 2 W-2 Box Number, if any

PR_BENE_W2_

CODE

N 14 W-2 Box Code, if any

PR_BENE_CALC_

METHOD

N 2 FA Valid Calculation Methods: FP, FH,

FA, AT, or PT. See Table 3.

PR_BENE_AMOUNT Y Currency 0.0000 Required for FH or FA.

PR_BENE_

PERCENT

Y Single 000.0000 Required for FP. Enter 5% as 05 or 5.

PR_BENE_MAX_

PERC

N 8 000.0000 Maximum percentage allowed on

timesheet for PT. Enter 5% as 05 or 5.

PR_BENE_YEAR_

MAX

N Currency 999,999.99 Maximum annual benefit calculation.

Required for all calculation methods.

PR_BENE_FIT N 2 Increase subject earnings? 0 = No; 1 =

Yes

PR_BENE_SS N 2 Increase subject earnings? 0 = No; 1 =

Yes

PR_BENE_MC N 2 Increase subject earnings? 0 = No; 1 =

Yes

PR_BENE_FUTA N 2 Increase subject earnings? 0 = No; 1 =

Yes

PR_BENE_SWT N 2 Increase subject earnings? 0 = No; 1 =

Yes

PR_BENE_SUTA N 2 Increase subject earnings? 0 = No; 1 =

Yes

PR_BENE_LWT N 2 Increase subject earnings? 0 = No; 1 =
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Table: tblPRBeneCode

Context Section: CONTEXT,BENEFITCODE,HEADER,HBENE

Field ID Req'd Field

Length

Default

Value

Notes

Yes

PR_BENE_LOCAL_

ER

N 2 Increase subject earnings? 0 = No; 1 =

Yes

PR_BENE_ALLOC_

METHOD

N 2 AE Valid Distribution Methods: AE, CE,

and DC. See Table 5.

PR_BENE_EARN_

DISTCODE

Y 1 Required if PR_BENE_ALLOC_

METHOD is AE; Must be a valid code

with a distribution type of B or P

(Maintain>Payroll>Distribution Codes).

PR_BENE_DIST_

CODE

Y User

Defined

Required if using a distribution method

of DC. Must be a valid code with a

distribution type of "B" or "P"

(Maintain>Payroll>Distribution Codes).

Detail

Table: tblPRBeneCode

Context Section: CONTEXT,BENEFITCODE,DETAIL,DBENE

Field ID Req'd Field

Length

Default

Value

Notes

PR_EC_CODE Y User

Defined

Required if calculation method of FP or

FH. Can have more than one earning

code. Must be a valid code

(Maintain>Payroll>Earning Codes).
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Importing Deduction Codes

The following tables show examples of data fields used in the Deduction Codes section of the

MasterPR.DEF file:

Header

Table: tblPRDeductCode

Context Section: CONTEXT,DEDUCTIONCODE,HEADER,HDED

Field ID Req'd Field

Length

Default

Value

Notes

DEDUC_CODE Y User

Defined

Deduction Code ID

DEDUC_STATUS N 1 A A (Active), I (Inactive), or D

(Discontinued)

DEDUC_TITLE Y User

Defined

Deduction Code Title

DEDUC_LIABACCT Y User

Defined

Liability G/L code. Must be a valid

chart of accounts code

(Maintain>Chart of Accounts Codes).

DEDUC_W2_BOX_

NUM

N 2 W-2 Box Number, if any

DEDUC_W2_BOX_

CODE

N 14 W-2 Box Code, if any

DEDUC_CALC_

METHOD

N 2 FA Valid Calculation Methods: FP, FH,

FA, AT, and PT. See Table 3.

DEDUC_AMOUNT Y Currency 0.0000 Required for FH or FA.

DEDUC_PERCENT Y Single 000.0000 Required for FP. Enter 5% as 05 or 5.

DEDUC_MAX N Currency 999,999.99 Required for all calculation methods.

DEDUC_FED_FIT N 2 Decreases subject earnings. 0 = No;
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Table: tblPRDeductCode

Context Section: CONTEXT,DEDUCTIONCODE,HEADER,HDED

Field ID Req'd Field

Length

Default

Value

Notes

1 = Yes

DEDUC_FED_SOCIAL_

SEC

N 2 Decreases subject earnings. 0 = No;

1 = Yes

DEDUC_FED_

MEDICARE

N 2 Decreases subject earnings. 0 = No;

1 = Yes

DEDUC_FED_FUTA N 2 Decreases subject earnings. 0 = No;

1 = Yes

DEDUC_STATE_SWT N 2 Decreases subject earnings. 0 = No;

1 = Yes

DEDUC_STATE_SUTA N 2 Decreases subject earnings. 0 = No;

1 = Yes

DEDUC_LOCAL_LWT N 2 Decreases subject earnings. 0 = No;

1 = Yes

DEDUC_LOCAL_

EMPLOYER

N 2 Decreases subject earnings. 0 = No;

1 = Yes

DEDUC_MAX_PERC N 8 000.0000 Maximum percentage allowed on

timesheet for PT. Enter 5% as 05 or

5.
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Detail

Table: tblPRDeductCodeEarning

Context Section: CONTEXT,DEDUCTIONCODE,DETAIL,DDED

Field ID Req'd Field

Length

Default

Value

Notes

PR_EC_CODE Y User

Defined

Required if calculation method of FP or FH.

Can have more than one earning code.

Must be a valid code

(Maintain>Payroll>Earning Codes).

Importing Workers' Compensation Codes

The following tables show examples of data fields used in the Workers' Comp Codes section of the

MasterPR.DEF file:

Header

Table: tblPRWCCode

Context Section: CONTEXT,WORKCOMPCODE,HEADER,HWC

Field ID Req'd Field

Length

Default

Value

Notes

PRWC_CODE Y User

Defined

Workers' Comp Code ID

PRWC_STATUS N 1 A A (Active), I (Inactive), or D

(Discontinued)

PRWC_TITLE Y User

Defined

Workers' Compensation Code Title

PRWC_AATRIX_TAX_

TYPE

N 60 <None> Defaults to <None>. This is the State

assigned to the Workers'

Compensation Code.

PRWC_CHECKSTUB N 1 0 0 = No; 1 = Yes. Available if PRWC_
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Table: tblPRWCCode

Context Section: CONTEXT,WORKCOMPCODE,HEADER,HWC

Field ID Req'd Field

Length

Default

Value

Notes

PAIDBY is ER

PRWC_PAIDBY Y 2 ER ER - Employer; EE - Employee

PRWC_EXPENSE_

ACCOUNT

Y User

Defined

Must be a valid chart of accounts code

(Maintain>Chart of Accounts Codes).

Required for paid by Employer.

PRWC_LIABILITY_

ACCOUNT

Y User

Defined

Must be a valid chart of accounts code

(Maintain>Chart of Accounts Codes).

PRWC_CALC_

METHOD

N 2 RE Valid Calculation Methods: RE , RH,

and RW. See Table 3.

PRWC_RATE N Single 0.00000 Rate

PRWC_

ADJUSTMENT_

FACTOR

N Single 0.0000 Adjustment Factor

PRWC_MAX_

SUBJECT_

WAGES

N Currency 999,999.99 Maximum Subject Wages

PRWC_

ALLOCATION_

METHOD

N 2 AE Valid Distribution Methods: AE, CE,

and DC. See Table 5.

PRWC_ALLOC_DIST_

CODE

Y User

Defined

Required for a distribution method of

DC. Must be a valid code with a

distribution type of "B" or "P"

(Maintain>Payroll>Distribution

Codes).
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Detail

Table: tblPRWCCodeEarning

Context Section: CONTEXT,WORKCOMPCODE,DETAIL,DWC

Field ID Req'd Field

Length

Default

Value

Notes

PR_EC_CODE Y User

Defined

Required if calculation method of RE or RW.

Can have more than one earning code. Must

be a valid code (Maintain>Payroll>Earning

Codes).
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Importing Leave Codes

The following tables show examples of data fields used in the Leave Codes section of the

MasterPR.DEF file:

Header

Table: tblPRLeaveCode

Context Section: CONTEXT,LEAVECODE,HEADER,HLEAVE

Field ID Req'd Field

Length

Default

Value

Notes

PR_LV_CODE Y User

Defined

Leave Code ID

PR_LV_STATUS N 1 A A (Active), I (Inactive), or D

(Discontinued)

PR_LV_TITLE Y User

Defined

Leave Code Title

PR_LV_MAX_

ACCRUED_HRS

N Single 9999.9900 If line is not included in *.DEF file, it

defaults to 9999.99. If item is included

with no value, it defaults to 0.00.

PR_LV_MAX_

BALANCE_HRS

N Single 9999.9900 Must be greater than or equal to PR_

LV_MAX_

PR_LV_CALC_MAX_

SUBJECT_HRS

Y Single 0.0000 Required if calculation method of FP.

PR_LV_CALC_

METHOD

Y 2 FN Valid Calculation Methods: FN, AT,

FP, or PT. See Table 3.

PR_LV_CALC_HOURS Y Rate 0.0000 Required if calculation method of FN.

PR_LV_CALC_

PERCENT

Y Rate 000.0000 Required if calculation method of FP.

Enter 5% as 05 or 5.

PR_LV_CALC_MAX_

PERCENTAGE

N 8 000.0000 Maximum percentage allowed on

timesheet for PT. Enter 5% as 05 or 5.
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Detail

Table: tblPRLeaveCodeEarning

Context Section: CONTEXT,LEAVECODE,DETAIL,DLEAVE

Field ID Req'd Field

Length

Default

Value

Notes

PR_EC_CODE Y User

Defined

Required if calculation method of FP. Can

have more than one earning code. Must be a

valid code (Maintain>Payroll>Earning

Codes).

Importing Tax Codes

The following table shows examples of data fields used in the State Tax Codes section of the

MasterPR.DEF file:

State Header

Table: tblPRStateTaxSetup

Context Section: CONTEXT,STATETAX,HEADER,HSTATETAX

Field ID Req'd Field

Length

Default

Value

Notes

PRST_CODE Y 2 State Code

PRST_WHTAX Y 2 No State Withholding Tax. If SUTA is

"No," then this must be "Yes." 1 =

Yes. Blank or any other value = No.

PRST_EMPLOYER_

TAXID_SWT

N 8 State Withholding Tax Account ID.

PRST_SUTA Y 2 Yes State Unemployment Tax. If WHTAX

is "No," then SUTA must be "Yes." 0

= No. Blank or any other value =

Yes.
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Table: tblPRStateTaxSetup

Context Section: CONTEXT,STATETAX,HEADER,HSTATETAX

Field ID Req'd Field

Length

Default

Value

Notes

PRST_EMPLOYER_

TAXID_SUTA

N 8 State Unemployment Tax Account

ID.

PRST_SWT_LIAB Y User

Defined

Required if SWT is selected. Must be

set up using Maintain>Chart of

Accounts Codes.

PRST_SUTA_

EMPLOYER

Y 2 If SUTA tax is imported, must be

either employer or employee paid.

Employer paid. 1 = Yes; 0 = No

PRST_SUTA_

EMPLOYEE

Y 2 If SUTA tax is imported, must be

either employer or employee paid.

Employee paid. 1 = Yes; 0 = No

PRST_SUTA_EXPENSE Y User

Defined

Required if SUTA is selected and

employer paid. Must be set up using

Maintain>Chart of Accounts Codes.

PRST_SUTA_LIAB Y User

Defined

Required if SUTA is selected. Must

be set up using Maintain>Chart of

Accounts Codes.

PRST_SUTA_

MAXWAGES_EE

N Currency 0.00 Maximum subject wages—employee.

PRST_SUTA_PERC_EE N Single 000.0000 Employee rate. Enter 5% as 05 or 5.

PRST_SUTA_

MAXWAGES_ER

N Currency 0.00 Maximum subject wages—employer.

PRST_SUTA_PERC_ER N Single 000.0000 Employer rate. Enter 5% as 05 or 5.

PRST_DISTMETHOD Y 2 AE Valid Distribution Methods: AE, CE,

and DC. See Table 5.
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Table: tblPRStateTaxSetup

Context Section: CONTEXT,STATETAX,HEADER,HSTATETAX

Field ID Req'd Field

Length

Default

Value

Notes

PRST_DISTCODE Y User

Defined

Required if using a distribution

method of DC. Must be a valid code

with a distribution type of "B" or "P"

(Maintain>Payroll>Distribution

Codes).

PRST_

SUTACALCMETHOD

Y 1 Y Valid Calculation Methods: Y or C.

See Table 3.

PRST_FUTA_

CROVERRIDE

N 2 FUTA Override Default Credit Rate.

1 = Yes; 0 = No

PRST_FUTA_

CREDITRATE

N Single 000.0000% FUTA Credit Rate.

The following tables show examples of data fields used in the Other Tax Codes section of the

MasterPR.DEF file.

Local Header

Table: tblPRLocalCode

Context Section: CONTEXT,LOCALTAX,HEADER,HLOCALTAX

Field ID Req'd Field

Length

Default

Value

Notes

PRLT_CODE Y User

Defined

Other Tax Code

PRLT_STATUS N 1 A A (Active), I (Inactive), or D (Discontinued)

PRLT_TITLE Y User

Defined

Other Tax Title

PRLT_AATRIX_ Y 60 Aatrix Tax Type, defaults to Local Tax.
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Table: tblPRLocalCode

Context Section: CONTEXT,LOCALTAX,HEADER,HLOCALTAX

Field ID Req'd Field

Length

Default

Value

Notes

TAX_TYPE Other tax types: California State Disability

Insurance, New Jersey State Disability

Insurance, New Jersey State Private

Disability Insurance, New Jersey State

Private Family Disability Insurance, New

York State Disability Insurance, or Rhode

Island State Disability Insurance. NOTE:

Additional tax types are available from

Aatrix but must be selected using the

Maintain>Payroll>Other Taxes form.

PRLT_EMPLOYER_

TAXID

N Other Tax Employer Tax ID number.

PRLT_LWT N 1 No If Other withholding tax is imported, must

be either employee and/or employer paid.

Employee (LWT) paid. 1 = Yes; 0 = No

PRLT_CALCBASIS N 2 TE Valid Calculation Basis: TE (Taxable

Earnings), SW (State Withholding), or FW

(Federal Withholding).

PRLT_LWT_

LIABACCT

Y User

Defined

Required for employee paid other

withholding tax codes. Must be set up

using Maintain>Chart of Accounts Codes.

PRLT_LWT_

CALCMETHOD

Y 47 Required for employee paid other

withholding tax codes. Valid Calculation

Types: Annual Base Tax, Annual Tiered

Tax with Cap Option, Base Tax per Period

with MinimumWage Threshold, Percent

of Annual Wages with Cap Option, or

Percent of Wages with Pay Cycle Cap

Option.
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Table: tblPRLocalCode

Context Section: CONTEXT,LOCALTAX,HEADER,HLOCALTAX

Field ID Req'd Field

Length

Default

Value

Notes

PRLT_ERLT N 1 No If Other withholding tax is imported, must

be either employee and/or employer paid.

Employer (ERLT) paid. 1 = Yes; 0 = No

PRLT_ER_LT_

EXPACCT

Y User

Defined

Required for employer paid other

withholding tax codes. Must be set up

using Maintain>Chart of Accounts Codes.

PRLT_ER_LT_

LIABACCT

Y User

Defined

Required for employer paid other

withholding tax codes. Must be set up

using Maintain>Chart of Accounts Codes.

PRLT_ER_

CALCMETHOD

Y 47 Required for employer paid other

withholding tax codes. Valid Calculation

Types: Base Tax per Period with Minimum

Wage Threshold, Fixed Amount, or

Percent of Annual Wages with Cap

Option.

Detail

The following table Field IDs are only available if the tblPRLocalCode has Field ID PRLT_LWT = 1 in the

Other Tax Codes section of the MasterPR.DEF file.

Table: tblPRLocalRates

Context Section: CONTEXT,LOCALTAX,DETAILRATE,DLOCALTAXEE

Field ID Req'd Field

Length

Default Value Notes

PRLT_AR_EE_

LOCALCODE

Y User

Defined

Other Tax Code

PRLT_AR_EE_ N Currency 0.00 Base Tax. Required if PRLT_
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Table: tblPRLocalRates

Context Section: CONTEXT,LOCALTAX,DETAILRATE,DLOCALTAXEE

Field ID Req'd Field

Length

Default Value Notes

BASETAX LWT_CALCMETHOD is Annual

Base Tax, Annual Tiered Tax

with Cap Option, or Base Tax per

Period with MinimumWage

Threshold.

PRLT_AR_EE_

PERCENT

N Single 000.0000 Percent. Required if PRLT_

LWT_CALCMETHOD is Annual

Tiered Tax with Cap Option,

Percent of Annual Wages with

Cap Option, or Percent of Wages

with Pay Cycle Cap Option.

Enter 5% as 05 or 5.

PRLT_AR_EE_

AMOUNTUNDER

N Currency 0.00 Taxable Amount Under.

Required if PRLT_LWT_

CALCMETHOD is Annual Tiered

Tax with Cap Option or Percent

of Annual Wages with Cap

Option.

PRLT_AR_EE_

EXCLUSION

N Currency 0.00 Exclusion amount. Required if

PRLT_LWT_CALCMETHOD is

Annual Tiered Tax with Cap

Option.

PRLT_AR_EE_

CALCMETHOD

N 12 Calculation Methods: Year to

Date or Current. Required if

PRLT_LWT_CALCMETHOD is

Percent of Annual Wages with

Cap Option.

PRLT_AR_EE_

WAGETHRES

N Currency 0.00 Wage Threshold. Required if
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Table: tblPRLocalRates

Context Section: CONTEXT,LOCALTAX,DETAILRATE,DLOCALTAXEE

Field ID Req'd Field

Length

Default Value Notes

PRLT_LWT_CALCMETHOD is

Base Tax per Period with

MinimumWage Threshold.

PRLT_AR_EE_

THRESPERIOD

N 14 Wage Threshold Periods:

Calendar Month or Calendar

Year. Required if PRLT_LWT_

CALCMETHOD is Base Tax per

Period with MinimumWage

Threshold.

PRLT_AR_EE_

PAYCYCLE

N 11 Monthly,

Semimonthly,

Biweekly,

Weekly

Pay Cycle: Monthly,

Semimonthly, Biweekly, and

Weekly. Required if PRLT_

LWT_CALCMETHOD is Percent

of Wages with Pay Cycle Cap

Option.

PRLT_AR_EE_

PAYCYCLECAP

N Currency 0.00 Pay Cycle Cap. Required if

PRLT_LWT_CALCMETHOD is

Percent of Wages with Pay

Cycle Cap Option.

Detail

The following table Field IDs are only available if the tblPRLocalCode has Field ID PRLT_ERLT = 1 in the

Other Tax Codes section of the MasterPR.DEF file.
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Table: tblPRLocalRates

Context Section: CONTEXT,LOCALTAX,DETAILRATE,DLOCALTAXER

Field ID Req'd Field

Length

Default

Value

Notes

PRLT_AR_ER_

LOCALCODE

Y User

Defined

Other Tax Code

PRLT_AR_ER_

BASETAX

N Currency 0.00 Base Tax. Required if PRLT_ER_

CALCMETHOD is Base Tax per

Period with MinimumWage

Threshold.

PRLT_AR_ER_

PERCENT

N Single 000.0000 Percent. Required if PRLT_ER_

CALCMETHOD is Percent of

Annual Wages with Cap Option.

Enter 5% as 05 or 5.

PRLT_AR_ER_

AMOUNTUNDER

N Currency 0.00 Taxable Amount Under. Required

if PRLT_ER_CALCMETHOD is

Percent of Annual Wages with Cap

Option.

PRLT_AR_ER_

FIXEDAMOUNT

N Currency 0.00 Fixed Amount. Required if PRLT_

ER_CALCMETHOD is Fixed

Amount.

PRLT_AR_ER_

CALCMETHOD

N 12 Calculation Methods: Year to Date

or Current. Required if PRLT_ER_

CALCMETHOD is Percent of

Annual Wages with Cap Option.
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Table: tblPRLocalRates

Context Section: CONTEXT,LOCALTAX,DETAILRATE,DLOCALTAXER

Field ID Req'd Field

Length

Default

Value

Notes

PRLT_AR_ER_

WAGETHRES

N Currency 0.00 Wage Threshold. Required if

PRLT_ER_CALCMETHOD is

Base Tax per Period with Minimum

Wage Threshold.

PRLT_AR_ER_

THRESPERIOD

N 14 Wage Threshold Periods: Calendar

Month or Calendar Year. Required

if PRLT_ER_CALCMETHOD is

Base Tax per Period with Minimum

Wage Threshold.

Detail

The following table Field IDs are only available if the tblPRLocalCode has Field ID PRLT_LWT = 1 in the

Other Tax Codes section of the MasterPR.DEF file.

Table: tblPRLocalRates

Context Section: CONTEXT,LOCALTAX,DETAILEXEMPT,DLOCALEXEMPT

Field ID Req'd Field

Length

Default

Value

Notes

PRLT_EXEMPT_

LOCALCODE

Y User

Defined

Other Tax Code

PRLT_EXEMPT_

CODE

N User

Defined

Exemptions/Deductions Code.

Only available if PRLT_LWT_

CALCMETHOD is Annual Tiered

Tax with Cap Option or Percent of

Annual Wages with Cap Option.
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Table: tblPRLocalRates

Context Section: CONTEXT,LOCALTAX,DETAILEXEMPT,DLOCALEXEMPT

Field ID Req'd Field

Length

Default

Value

Notes

PRLT_EXEMPT_DESC N User

Defined

Exemptions/Deductions Code

Description

PRLT_EXEMPT_

ANNUALAMOUNT

N Currency 0.00 Exemptions/Deductions Annual

Amount

Importing Employee Information

The following tables show examples of data fields used in the Employee Information section of the

MasterPR.DEF file:

Header

Table: tblPREE

Context Section: CONTEXT,EMPLOYEE,HEADER,HEMPINF

Field ID Req'd Field

Length

Default

Value

Notes

EMP_EMPID Y User

Defined

Employee ID

EMP_STATUS N 1 A A (Active), I (Inactive), or D

(Discontinued)

EMP_LASTNAME Y User

Defined

Employee Last Name

EMP_FIRSTNAME Y User

Defined

Employee First Name

EMP_MI N 1 Employee Middle Initial

EMP_SSN Y 11 Employee Social Security Number

Format:
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Table: tblPREE

Context Section: CONTEXT,EMPLOYEE,HEADER,HEMPINF

Field ID Req'd Field

Length

Default

Value

Notes

xxx-xx-xxxx

EMP_I9 N 2 No I-9 on File: 0 = No; 1 = Yes

EMP_CITIZENSHIP N 25 Employee Citizenship

EMP_

MARITALSTATUS

N 25 Employee Marital Status

EMP_GENDER N 2 Employee Gender: Female (F) or

Male (M)

EMP_ETHNICITY N 25 Employee Ethnicity

EMP_WORKPHONE N 21 Employee Work Phone Format:

(xxx) xxx-xxxx Ext. xxxx. Dashes

required.

EMP_USERID_GUID N See Notes

for format.

The system user ID that is

associated with the employee ID. A

blank GUID format: {00000000-

0000-0000-0000-000000000000}

EMP_HIRED N Date Current

Date

Can be 6, 8, or 10 digit date.

EMP_ACTION N Date Can be 6, 8, or 10 digit date.

EMP_

LASTDAYWORKED

N Date Can be 6, 8, or 10 digit date.

EMP_TERMINATED N Date Can be 6, 8, or 10 digit date.

EMP_BIRTHDATE N Date Can be 6, 8, or 10 digit date.

EMP_ADDRESS N 80 Employee Address. Use "^" to

separate address lines.
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Table: tblPREE

Context Section: CONTEXT,EMPLOYEE,HEADER,HEMPINF

Field ID Req'd Field

Length

Default

Value

Notes

EMP_CITY N 30 Employee City

EMP_STATE N 2 Employee State

EMP_ZIP N 10 Employee ZIP. 9 digit zip code

must include dash after 5th

number.

EMP_ZIP N 47 Employee Country

EMP_VOICE N 21 Employee Phone Format:

(xxx) xxx-xxxx Ext. xxxx. Dashes

required.

EMP_FAX N 21 Employee Fax Format: (xxx) xxx-

xxxx. Dashes required.

EMP_EREMAIL N 60 Employee personal or home email

address

EMP_ECNAME N 30 Emergency Contact Name

EMP_ECPHONE N 21 Emergency Contact Phone

Format: (xxx) xxx-xxxx

EMP_ECRELATION N 20 Emergency Contact's Relationship

to Employee

EMP_ECEMAIL N 60 The emergency contact's email

address

EMP_PROCGROUP Y User

Defined

Must be set up using

Maintain>Payroll>Processing

Groups.

EMP_CLASS N User

Defined

Optional Class Designation
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Table: tblPREE

Context Section: CONTEXT,EMPLOYEE,HEADER,HEMPINF

Field ID Req'd Field

Length

Default

Value

Notes

EMP_POSITION N User

Defined

Optional Position Designation

EMP_EMPTYPE N 25 Employee Type

EMP_

MILITARYSTATUS

N 25 Military Status

EMP_OCCUPATION N 10 Occupational Code

EMP_LICENSENUM N 15 Drivers License Number

EMP_DLSTATE N 2 Any existing state code

EMP_DLEXPIRATION N Date Drivers License Expiration Date.

Can be 6, 8, or 10 digit date.

EMP_DLCLASS N 25 Drivers License Class

EMP_SALARIED_

HOURLY

Y 1 S S (Salaried) or H (Hourly)

EMP_SALARY Y Currency Salary per Pay Cycle. Required if

salaried.

EMP_HRLYRATE Y Single Hourly Rate. Required if hourly.

EMP_EQ_HOURLY_

SAL

Y 20 Equivalent Hourly Rate for

Calculations. Required if Salary.

EMP_

DIRECTDEPOSIT

N 2 Direct Deposit: 0 = No; 1 = Yes

EMP_DISABLE_

PRENOTE

N 2 No Disable Pre-note: 0 = No; 1 = Yes

EMP_FITMARSTS Y 1 S Federal filing status. S (Single), M

(Married), H (Head of Household)
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Table: tblPREE

Context Section: CONTEXT,EMPLOYEE,HEADER,HEMPINF

Field ID Req'd Field

Length

Default

Value

Notes

EMP_FITEXEMPT N 2 0 Federal exemptions claimed

EMP_FITADDLWH N Currency 0.00 Additional Federal Withholding

EMP_FITNONRESALIEN N 1 Nonresident Alien Status. 0 = No; 1

= Yes

EMP_FIT24PRIOR2020 N 1 W-4 completed prior to 2020. 0 =

No; 1 = Yes

EMP_

FITEXEMPTSTATUS

N 1 Tax Exempt Status. 0 = No; 1 =

Yes

EMP_FITMULTIPLEJOBS N 1 Multiple Jobs. 0 = No; 1 = Yes

EMP_

FITDEPENDENTAMT

N Currency 0.00 Dependent Amount

EMP_

FITOTHERINCOMEAMT

N Currency 0.00 Other Income Amount

EMP_

FITDEDUCTIONAMT

N Currency 0.00 Deductions Amount

EMP_FITADDLWH2020 N Currency 0.00 Additional Federal Withholding

EMP_1095 N 2 N Issue Electronic Form 1095: 0 =

No; 1 = Yes

EMP_EIC N 1 N EIC status. N (None), M (Married

with Both Filing), or S

(Single/Married with One Filing)

EMP_SUTA N 2 State unemployment state. Two

digit state postal abbreviation.

EMP_SWT N 2 State withholding tax. Two digit

state postal abbreviation.
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Table: tblPREE

Context Section: CONTEXT,EMPLOYEE,HEADER,HEMPINF

Field ID Req'd Field

Length

Default

Value

Notes

EMP_SWTADDLWH N Currency 0.00 Additional state withholding

EMP_

SWTFILINGSTATUS

N 2 State filing status. Required for

some states.

EMP_

SWTEXEMPTION

N 2 State exemptions claimed.

Required for some states.

EMP_

SWTDEDUCTION

N 2 State deductions claimed.

Required for some states.

EMP_SWTCREDITS N State Withholding Tax Credits

EMP_

SWTALLOWANCES

N Allowances for Deductions

EMP_

SWTSPOUSESSN

N 11 Spouse Social Security Number

Format: xxx-xx-xxxx

EMP_MQGE N 2 No Medicare Qualified Government

Employee. 0 = No; 1 = Yes

EMP_STATUTORY N 2 No W-2 Box check box—Statutory

Employee. 0 = No; 1 = Yes

EMP_

RETIREMENTPLAN

N 2 No W-2 Box check box—Retirement

Plan. 0 = No; 1 = Yes

EMP_3RDPARTY_

SICK_PAY

N 2 No W-2 Box check box—3rd Party Sick

Pay. 0 = No; 1 = Yes

EMP_EFILEW2 N 2 No Issue employee W-2 electronically

through Aatrix ® check box. 0 = No;

1 = Yes

EMP_EFEMAIL N 60 The Electronic W-2 email address

VOUCHER_PAPER N 1 1 Print Paper Voucher: 0 = No; 1 =
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Table: tblPREE

Context Section: CONTEXT,EMPLOYEE,HEADER,HEMPINF

Field ID Req'd Field

Length

Default

Value

Notes

Yes

VOUCHER_EMAIL N 1 0 Email Voucher: 0 = No; 1 = Yes

VOUCHER_EMAILADDR Y* 255 0 Voucher Email Address. *Required

if VOUCHER_EMAIL is Yes. Must

be in email format.

VOUCHER_

EMAILTEMPLATE

Y 30 <Default> Voucher Process Template.

Required if VOUCHER_EMAIL is

Yes; otherwise <Default> displays.

EMP_NOTES N Notes

Direct Deposit Detail

Table: tblPREEDirectDep

Context Section: CONTEXT,EMPLOYEE,DETAIL,DEMPINF

Field ID Req'd Field

Length

Default

Value

Notes

MTNEMP_ROUTING Y 9 9 digit Bank Routing Number

MTNEMP_ACCNUM Y 17 Employee's Checking or Savings

account number

MTNEMP_PERC Y Single 000.0000 Percentage of net pay. All percentages

must total 100%. Enter 5% as 05 or 5.
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Table: tblPREEDirectDep

Context Section: CONTEXT,EMPLOYEE,DETAIL,DEMPINF

Field ID Req'd Field

Length

Default

Value

Notes

MTNEMP_AMOUNT N Currency 0.00 An exact dollar amount to be deposited

into an account.

MTNEMP_TYPE Y 2 Direct Deposit Type: 22 for checking

and 32 for savings. Required if direct

deposit is selected and if Direct Deposit

is installed.

Employee Other Taxes Detail

Table: tblPREEOtherTaxCode

Context Section: CONTEXT,EMPLOYEE,DETAIL,DEMPOT

Field ID Req'd Field

Length

Default

Value

Notes

PRMTN_GRID

OC_CODE

N User

Defined

Other Taxes Employee Paid Tax code.

Must be set up using

Maintain>Payroll>Other Taxes.

PRMTN_GRID

OC_ADDITIONALWH

N Currency 0.00 Additional other taxes to withhold form

each paycheck.
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Other Taxes Exemptions Detail

Table: tblPREELocalTaxExempt

Context Section: CONTEXT,EMPLOYEE,DETAIL,DEMPEMPT

Field ID Req'd Field

Length

Default

Value

Notes

PRMTN_GRID

OCEXEMPT_CODE

N User

Defined

Employee Other Taxes

Exemptions/Deductions code.

PRMTN_GRID

OCEXEMPT_

NUMBER

N 2 Employee Other Taxes

Exemptions/Deductions claimed.

Required if PRMTN_GRID_

OCEXEMPT_CODE is selected.

Importing Timesheets

Default, regular, or supplement timesheets can be imported. The following tables show examples of data

fields used in the Timesheets section of the MasterPR.DEF file:

Header

Table: tblPRTS

Context Section: CONTEXT,TIMESHEET,HEADER,HTS

Field ID Req'd Field

Length

Default

Value

Notes

TS_EMPLOYEEID Y User

Defined

Employee ID

TS_PROCGROUP Y User

Defined

If timesheet is default, this field is

ignored. The system validates the

processing group for the associated

employee.

TS_TYPE N 20 Valid timesheet types: D (Default), R

(Regular), and S (Supplemental)

TS_PAYDATE N Date Required if timesheet is regular; it is
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Table: tblPRTS

Context Section: CONTEXT,TIMESHEET,HEADER,HTS

Field ID Req'd Field

Length

Default

Value

Notes

ignored if it is default. If timesheet is

supplemental or regular and no date is

provided, the system uses the current

system date. Can be 6, 8, or 10 digit

date.

TS_BEGPERIODDATE N Date Required if timesheet is regular; it is

ignored if it is default. If timesheet is

supplemental or regular and no date is

provided, the system uses the

Processing Group Pay Period Begin

date. Can be 6, 8, or 10 digit date.

TS_ENDPERIODDATE N Date Required if timesheet is regular; it is

ignored if it is default. If timesheet is

supplemental or regular and no date is

provided, the system uses the

Processing Group Pay Period End date.

Can be 6, 8, or 10 digit date.

TS_SUTAWEEKS N Integer 0 Number of SUTA weeks for timesheet

information

TS_REF N 20 Timesheet reference number

TS_ID N 20 Timesheet reference
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Detail Earnings

Table: tblPRTSEarn

Context Section: CONTEXT,TIMESHEET,DETAILTSEARN,DTSEARN

Field ID Req'd Field

Length

Default

Value

Notes

TSEG_CODE Y User

Defined

Earning Code. At least one earning or

benefit code is required to save a

timesheet.

TSEG_HOURS N Single 0.0000 Earning Hours

TSEG_RATE N 8 0.0000 Used with Rate on Timesheet calculation

method

TSEG_AMOUNT N Currency 0.00 Earning Amount

TSEG_DISTCODE Y User

Defined

Must be a valid code with a distribution

type of "B" or "P"

(Maintain>Payroll>Distribution Codes).

Detail Benefits

Table: tblPRTSBene

Context Section: CONTEXT,TIMESHEET,DETAILTSBENE,DTSBENE

Field ID Req'd Field

Length

Default

Value

Notes

TSBG_CODE Y User

Defined

Benefit Code. At least one earning or

benefit code is required to save a

timesheet.

TSBG_AMOUNT N Currency 0.00 Benefit Amount

TSBG_RATE N 7 Used with Percentage on Timesheet

calculation method. Must be a positive

number greater than zero and cannot

exceed the Maximum Percentage set



The Payroll Module Data Fields

Table: tblPRTSBene

Context Section: CONTEXT,TIMESHEET,DETAILTSBENE,DTSBENE

Field ID Req'd Field

Length

Default

Value

Notes

on the Maintain>Payroll>Benefit

Codes such as 99.9999

Detail Deductions

Table: tblPRTSDeduct

Context Section: CONTEXT,TIMESHEET,DETAILTSDED,DTSDED

Field ID Req'd Field

Length

Default

Value

Notes

TSDG_CODE N User

Defined

Deduction Code

TSDG_AMOUNT N Currency 0.00 Deduction Amount

TSDG_RATE N 7 Used with Percentage on Timesheet

calculation method. Must be a positive

number greater than zero and cannot

exceed the Maximum Percentage set on

the Maintain>Payroll>Deduction Codes

such as 99.9999

Detail Workers' Compensation

Table: tblPRTSWC

Context Section: CONTEXT,TIMESHEET,DETAILTSWC,DTSWC

Field ID Req'd Field

Length

Default

Value

Notes

TSWG_CODE N User

Defined

Workers' Compensation Code

TSWG_HOURS N Single 0.00 Workers' Compensation Hours
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Detail Leave

Table: tblPRTSLeave

Context Section: CONTEXT,TIMESHEET,DETAILTSLEAVE,DTSLEAVE

Field ID Req'd Field

Length

Default

Value

Notes

TSLG_CODE N User

Defined

Leave Code

TSLG_HOURS N Single 0.00 Leave Hours

TSLG_RATE N 7 Used with Percentage on Timesheet

calculation method. Must be a positive

number greater than zero and cannot

exceed the Maximum Percentage set

on the Maintain>Payroll>Leave Codes

such as 99.9999

TSLG_HOURSACC N 8 0 Used with Amount on Timesheet

calculation method

Importing Adjust Employee Balances

The following tables show examples of data fields used in the Adjust Employee Balances section of the

MasterPR.DEF file:

Header

Table: tblPRHist

Context Section: CONTEXT,ADJUSTBALANCE,HEADER,HHIST

Field ID Req'd Field

Length

Default

Value

Notes

SAD_EMPLOYEEID Y User

Defined

Employee ID

SAD_ADJNUM Y 30 Adjustment numbers must be unique

within Employee ID.
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Table: tblPRHist

Context Section: CONTEXT,ADJUSTBALANCE,HEADER,HHIST

Field ID Req'd Field

Length

Default

Value

Notes

SAD_EFFDATE N Date Current

Date

Effective date of adjustment. Can be 6, 8,

or 10 digit date.

Detail Historical Earnings

Table: tblPRHistEarn

Context Section: CONTEXT,ADJUSTBALANCE,DETAILHISTEARN,DHISTEARN

Field ID Req'd Field Length Default

Value

Notes

SADEG_CODE N User Defined Earning Code ID

SADEG_HOURS N Single 0.00 Can be negative value.

SADEG_AMOUNT N Currency 0.00 Can be negative amount.

Detail Historical Benefits

Table: tblPRHistBene

Context Section: CONTEXT,ADJUSTBALANCE,DETAILHISTBENE,DHISTBENE

Field ID Req'd Field Length Default

Value

Notes

SADBG_CODE N User Defined Benefit Code ID

SADBG_AMOUNT N Currency 0.00 Can be negative amount.
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Detail Historical Deductions

Table: tblPRHistDeduct

Context Section: CONTEXT,ADJUSTBALANCE,DETAILHISTDED,DHISTDED

Field ID Req'd Field Length Default

Value

Notes

SADDG_CODE N User

Defined

Deduction Code ID

SADDG_AMOUNT N Currency 0.00 Can be negative amount.

Detail Historical Workers' Compensation

Table: tblPRHistWC

Context Section: CONTEXT,ADJUSTBALANCE,DETAILHISTWC,DHISTWC

Field ID Req'd Field

Length

Default

Value

Notes

SADWG_CODE N User

Defined

Workers' Comp Code ID

SADWG_HOURS N Single 0.00 Can be negative number.

SADWG_SUBJEARN N Currency 0.00 Can be negative amount.

SADWG_ERAMOUNT N Currency 0.00 Employer Amount. Can be

negative amount.

SADWG_EEAMOUNT N Currency 0.00 Employee Amount. Can be

negative amount.
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Detail Historical Leave

Table: tblPRHistLeave

Context Section: CONTEXT,ADJUSTBALANCE,DETAILHISTLEAVE,DHISTLEAVE

Field ID Req'd Field Length Default

Value

Notes

SADLG_CODE N User Defined Leave Code ID

SADLG_HOURS_

ACCRUED

N Single 0.00 Leave hours accrued. Can be

negative value.

SADLG_HOURS_

TAKEN

N Single 0.00 Leave hours taken. Can be

negative value.

Detail Historical Taxes

Table: tblPRHistTaxes

Context Section: CONTEXT,ADJUSTBALANCE,DETAILHISTTAX,DHISTTAXES

Field ID Req'd Field Length Default

Value

Notes

SADTG_TYPE N 4 Valid Tax Types: FIT, SS, MC,

FUTA, EIC, SWT, SWT2, SUTA,

LWT, and LER. See Table 6.

SADTG_JURIS Y 50 Required for tax types: LWT,

LER, SWT, or SUTA. Must use a

two digit state postal abbreviation

for SWT and SUTA.

SADTG_

SUTAWEEKS

N 2 0 SUTAWeeks

SADTG_SUBJEARN N Currency 0.00 Employee’s Subject Earnings.

Can be negative amount.

SADTG_

ERSUBJEARN

N Currency 0.00 Employer-Paid Subject Earnings.

Can be negative amount.
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Table: tblPRHistTaxes

Context Section: CONTEXT,ADJUSTBALANCE,DETAILHISTTAX,DHISTTAXES

Field ID Req'd Field Length Default

Value

Notes

SADTG_

GROSSTAXABLE

N Currency 0.00 Gross Taxable Earnings. Can be

negative amount.

SADTG_EEAMOUNT N Currency 0.00 Employee Amount. Can be

negative amount.

SADTG_ERAMOUNT N Currency 0.00 Employer Amount. Can be

negative amount.

Importing Email Templates

The following tables define the field references to be used in the Email Templates section of the

MasterGL.DEF file:

Note: This information is only available for A/R Billing and Payroll users.

Table: tblEmailTemplate

Context Section: CONTEXT,EMAILTEMPLATE,HEADER,HEMAILTPLT

Field ID Req'd Field

Length

Default

Value

Notes

EMAIL_TYPE Y 50 Email Process Type: Invoice,

Statement, or Voucher

EMAIL_PROCESS_

TEMPLATE

Y 50 Default Email Process Template for the

Process Type. Recommend

completing a "<Default>" email

process template for each email

process type imported.

EMAIL_FROM_

ADDRESS

Y 2000 From Email Address. Must be in

email format.

EMAIL_CC_ N 2000 Cc Email Address. Must be in email



The Purchase Orders Module Data Fields

Table: tblEmailTemplate

Context Section: CONTEXT,EMAILTEMPLATE,HEADER,HEMAILTPLT

Field ID Req'd Field

Length

Default

Value

Notes

ADDRESS format.

EMAIL_BCC_

ADDRESS

N 2000 Bcc Email Address. Must be in email

format.

EMAIL_SUBJECT N 5000 Subject line for Email Type/Email

Process Template.

EMAIL_MESSAGE N 5000 Email Message for Email Type/Email

Process Template.

The Purchase Orders Module Data Fields
The following are specific data field tables used to import data into the Purchase Order module:

Importing Item Codes

Multicurrency Users

The ITEM_CURTYPE field is only available if this module is installed and added to the organization by

the Administrator (Organization>Add a Module).

Order Entry Users

The ITEM_AVAILFORRESALE field is only available if this module is installed and added to the

organization.

Header

The following table defines the field references to be used in the PO Item Codes section of the

MasterPO.DEF file:
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Table: tblPOItems

Context Section: CONTEXT,ITEMCODES,HEADER,HITEMS

Field ID Req'd Field

Length

Default

Value

Notes

ITEM_CODE Y User

Defined

Item Code

ITEM_STATUS Y 1 A A (Active), I (Inactive), or D

(Discontinued)

ITEM_DESCRIPTION Y User

Defined

Item Code Description

ITEM_ITYPE Y 1 N Item Type: N (Non-Inventory), or S

(Services).

ITEM_CURTYPE Y 3 Active or inactive Currency code for

Item Code.

ITEM_STDQTY N Single 0.00 Standard Quantity

ITEM_PUR_GLCODE N User

Defined

Purchase GL Account. Must be set up

using Maintain>Chart of Accounts

Codes.

ITEM_DEF_DISTCODE N User

Defined

Distribution Code.

ITEM_UNITCOST N Currency 0.00 Unit Price

ITEM_WEIGHT N Single 0.0000 Weight

ITEM_WEIGHT_UNIT N 25 Weight Unit

ITEM_

AVAILFORRESALE

N 2 Available for Resale? 0 = No; 1 = Yes

ITEM_PREF_VENDOR N User

Defined

Preferred Vendor



The Purchase Orders Module Data Fields

Importing Purchase Orders

Encumbrance Users

The PO_CREATE_ENC and POENC_EFFDATE fields are only available if this module is installed and

added to the organization by the Administrator (Organization>Add a Module).

Multicurrency Users

The ITEM_CURTYPE and POENC_EXCHRATE fields are only available if this module is installed and

added to the organization.

Purchase Order Header

The following table defines the field Reference Number to be used in the Ready to Print or In Process

status only content section of the MasterPO.DEF file: Does not support UPDATEITEM.

Table: tblPODocument

Context Section: CONTEXT,PURCHASEORDER,HEADER,HPO

Field ID Req'd Field

Length

Default

Value

Notes

PO_NUMBER_TYPE Y 15 Reference Number Type is always Reference.

This will create a new purchase order.

Existing Purchase Orders cannot be

imported.

PO_NUMBER Y 15 Reference Number

PO_DATE Y Date Date is required. If no date is provided,

the system uses the current system

date. Can be 6, 8, or 10 digit.

PO_STATUS Y 2 Status. Can be In Process or Ready to

Print.

PO_DESCRIPTION Y 60 Description

PO_PLAYER_ID Y User

Defined

Vendor ID
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Table: tblPODocument

Context Section: CONTEXT,PURCHASEORDER,HEADER,HPO

Field ID Req'd Field

Length

Default

Value

Notes

PO_CURRENCY N 3 Active or inactive Currency code.

PO_CREATE_ENC N 1 Create Encumbrance? 0 = No; 1 = Yes

PO_CREATE_RECEIVE N 1 Skip Receiving? 0 = No; 1 = Yes

PO_SHIP_ADDR_CODE Y User

Defined

Shipping Address Code

PO_BILL_ADDR_CODE N 15 Billing Address Code

PO_ATTENTION N 50 Attention

PO_BUYER N 50 Buyer name

PO_FOB N 50 FOB, etc

PO_SHIPMETHOD N 50 Shipping Method

PO_COMMENT N 255 Comments

Purchase Order Item Detail

The following table defines the field references to be used for the Item Detail section of the

MasterPO.DEF file:

Table: tblPOTrans

Context Section: CONTEXT,PURCHASEORDER,DETAIL,DDETAIL

Field ID Req'd Field

Length

Default

Value

Notes

PO_LINE_ID Y Line ID, begin with Number 1. The

order of the line items.

PO_ITEM_CATEGORY N User

Defined

Category Code



The Purchase Orders Module Data Fields

Table: tblPOTrans

Context Section: CONTEXT,PURCHASEORDER,DETAIL,DDETAIL

Field ID Req'd Field

Length

Default

Value

Notes

PO_ITEMID Y User

Defined

Item Code

PO_ITEMDESC Y User

Defined

Item Code Description

PO_SPECIALNOTES N 255 Special Instructions

PO_GLCODE Y User

Defined

GL Code

PO_DISTCODE Y User

Defined

Distribution Code

PO_UNITTYPE Y 25 Purchase Unit

PO_QTY Y Single 0.00 Quantity

PO_UNITCOST Y Currency 0.00 Unit Price

PO_

DATEREQUIREDBY

N Date Date Required By. Can be 6, 8, or

10 digit.

PO_DATEPROMISED N Date Date Promised. Can be 6, 8, or 10

digit.

PO_REQUESTEDFOR N 70 Requested For

PO_REQ_NUMBER N User

Defined

Requisition Number

Note: GEN_CODING uses PO_GLCODE and PO_DISTCODE to create coding.

PO Coding Line Detail

The following table defines the field references to be used in the PO Coding Line Content section of the

MasterPO.DEF file: (Do not use GEN_CODING if importing Coding Lines)
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Table: tblPOTETrans

Context Section: CONTEXT,PURCHASEORDER,DETAIL,DCODING

Field ID Req'd Field

Length

Default

Value

Notes

POENC_LINE_ID Y Line Number. The line item must

correlate with a Purchase Order

Item Detail PO_LINE_ID.

POENC_EFFDATE N* Date Effective Date. Can be 6, 8, or 10

digit. Required if PO_CREATE_

ENC is 1 (Yes).

POENC_SEGMENT_

{SEGMENT NAME}

Y User

Defined

Replace {segment name} with the

actual segment name (one line in

*.DEF file for each).

POENC_AMOUNT Y Currency 0.00 Amount

POENC_EXCHRATE N* 8 0.0000000 Currency Exchange Rate.

Required if PO_CREATE_ENC is 1

(Yes) and PO_CURRENCY is not

the organization's functional

currency.

Context ID Section Example

CONTEXTIDPOSITION - Location of context ID

FILETYPE - File type of import file, for example, CSV

DISCARDFIRSTNRECORDS - Disregard N handles records in import file.

UPDATEIGNOREBLANK - Allows to import Purchase Order Item Detail for rows that miss data elements

when other rows include all data elements.

GEN_CODING - Create Coding Line Detail based on PO_GLCODE and PO_DISTCODE. Do not use

GEN_CODING if importing PO Coding Lines.
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The Sales Order Entry Module Data Fields
The following are specific data field tables used to import data into the Sales Order Entry module:

Importing Sales Orders

Header

The following table defines field references used in the Sales Order section of the MasterOE.DEF file:

Note that the Customer ID must be listed before the shipping address code in the CSV file in order for it to

import.

Table: tblOESalesOrder

Context Section: CONTEXT,OENTRY,HEADER,HSALESORD

Field ID Req'd Field

Length

Default

Value

Notes

SALESORD_NUMBER Y 15 Order Number

SALESORD_DATE Y Date Order Date. Can be 6, 8, or 10 digit date.

SALESORD_

COMMENTS

N 255 Comments

SALESORD_

CASHCUSTOMER

N 2 Cash Sale? 0 = No; 1 = Yes

SALESORD_

ORDERTYPE

Y 1 Order Type - Q (Quote) or S (Sales

Order)

SALESORD_CUSTID Y User

Defined

Customer ID

SALESORD_

SHIPADDRCODE

Y User

Defined

Shipping Address Code

SALESORD_

SALESTAXCODE

Y* User

Defined

Sales Tax Code. *Required if user is

taxable.

SALESORD_

REQSHIPDATE

Y Date Requested Shipping Date. Can be 6, 8,

or 10 digit date.
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Table: tblOESalesOrder

Context Section: CONTEXT,OENTRY,HEADER,HSALESORD

Field ID Req'd Field

Length

Default

Value

Notes

SALESORD_

SHIPMETHOD

Y 50 Shipping Method ID

SALESORD_

CUSTPONUMBER

N 25 Customer Purchase Order Number

SALESORD_

PMTMETHOD

Y 25 Payment Method

SALESORD_

AMTRECEIVED

Y* Currency 0.00 Amount Received. *Required if

SALESORD_CASHCUSTOMER is Y.

SALESORD_

CASHGLACCT

Y* User

Defined

Cash General Ledger Account.

*Required if SALESORD_

CASHCUSTOMER is Y.

SALESORD_

DEPOSITNUM

N 25 Deposit Number

Detail

Table: tblOESalesOrderDetail

Context Section: CONTEXT,OENTRYDETAIL,HEADER,DSALESORD

Field ID Req'd Field

Length

Default

Value

Notes

SALESORD_DTL_

CHARGECODE

Y User

Defined

Charge Code

SALESORD_DTL_

QTYORDER

Y 8 0.00 Order Quantity

SALESORD_DTL_

FIXPRICE

N Currency Fixed Charge. Used with Charge

Code Calculation Method of VC.



The Sales Order Entry Module Data Fields

Table: tblOESalesOrderDetail

Context Section: CONTEXT,OENTRYDETAIL,HEADER,DSALESORD

Field ID Req'd Field

Length

Default

Value

Notes

Calculated based on charge

code.

SALESORD_DTL_

SALESPRICE

N Currency Unit Price. Used with Charge

Code Calculation Method of VC.

Calculated based on charge

code.

SALESORD_DTL_

LINENUM

Y 2 Order Detail Line #

SALESORD_DTL_

SENDTOFULFILLMENT

N 2 Send to Fulfillment? 0 = No; 1 =

Yes
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The following is a list of reference tables that will help you when importing:

Table 1: Transaction Source Codes
Some transaction source codes are reserved for transactions that are processed by the system.

Therefore, if these transactions are being imported, an alternate transaction source must be used. The

following table displays all transaction codes, determines if a code is importable, and if it is not, the code

that should be used is listed in the Alternate column. Budget and Encumbrance entries are one-sided.

Code Transaction Type Import Alternate

APC A/P Manual Checks Y

API A/P Invoices Y

APM A/P Credits Y

APS A/P System Generated Checks/Vouchers N APC

APV A/P Void Checks/Vouchers/Invoices N APC

ARB A/R Invoices Y

ARC A/R Receipts Y

ARM A/R Credits Y

ARP A/R Prepayment (Note that ARP does not require a

TETRANS_MATCH_DOCNUM.)

Y

ARS A/R System Generated Invoices N ARB

ARV A/R Void Invoices N ARB

BD Budget Y

CD Cash Disbursements Y

CDS Write Checks N CD

CR Cash Receipts Y
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Code Transaction Type Import Alternate

CRS Receipt Writing N CR

ENC Encumbrances Y

ENL Encumbrance Liquidations Y

JV Journal Vouchers Y

JVA Journal Vouchers - Allocation Management N JV

JVD Journal Vouchers - Depreciation/Disposal N JV

PRC Payroll Manual Checks N CD

PRS Payroll System Generated Checks/Vouchers N CD

PRV Payroll Void Checks/Vouchers N CD

VCK Void Checks N CD

Table 2: 1099 Box Numbers
The following tables contain 1099 Box Numbers. These numbers are assigned to vendors on the

Maintain>Accounts Payable>Vendors>1099 Information tab.

1099 NEC

1099 NEC Code Description

N/A Not Applicable

NEC-01 Nonemployee Compensation

NEC-04 Federal Income Tax Withheld

NEC-05 State Income Tax Withheld

NEC-07 State Payment

Note: In the MIP 2020.3 release, any MISC-07 coded activities with an effective date of 1/1/2020 or

later have been automatically updated to NEC-01.



Table 2: 1099 Box Numbers

1099 MISC

1099 MISC Code Description

N/A Not Applicable

MISC-01 Rents

MISC-02 Royalties

MISC-03 Other Income

MISC-04 Federal Income Tax Withheld

MISC-05 Fishing Boat Proceeds

MISC-06 Medical Health Care Payments

MISC-07 Non-employee Compensation (Deprecated)

MISC-08 Substitute Payments in Lieu of Dividends or Interest

MISC-09 Crop Insurance Proceeds

MISC-10 Gross Proceeds Paid to an Attorney

MISC-12 Section 409A Deferrals

MISC-13 Excess Golden Parachute Payments

MISC-14 Nonqualified Deferred Compensation

MISC-15 State Tax Withheld

MISC-15a Section 409A Deferrals (Deprecated)

MISC-15b Section 409A Income (Deprecated)

MISC-16 State Tax Withheld (Deprecated)

MISC-17 State Payment

Note: In the MIP 2020.3 release, any MISC-07 coded activities with an effective date of 1/1/2020 or

later have been automatically updated to NEC-01.
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1099 DIV

1099 DIV Code Description

N/A Not Applicable

DIV-01a Total Ordinary Dividends

DIV-01b Qualified Dividends

DIV-02a Total Capital Gain Distributed

DIV-02b Unrecaptured Section 1250 Gain

DIV-02c Section 1202 Gain

DIV-02d Collectibles (28%) Gain

DIV-03 Nondividend Distributions

DIV-04 Federal Income Tax Withheld

DIV-05 Section 199A Dividends

DIV-06 Investment Expenses

DIV-09 Cash Liquidation Distribution

DIV-10 Noncash Liquidation Distribution

DIV-11 Exempt-Interest Dividends

DIV-12 Specified Private Activity Bond Interest

DIV-14 State Tax Identification Number

DIV-15 State Tax Withheld

1099 INT

1099 INT Code Description

N/A Not Applicable

INT-01 Interest Income

INT-02 Early Withdraw Penalty



Table 2: 1099 Box Numbers

1099 INT Code Description

INT-03 Interest on U.S. Savings Bonds and Treasury Obligations

INT-04 Federal Income Tax Withheld

INT-05 Investment Expenses

INT-08 Tax-Exempt Interest

INT-09 Specified Private Activity Bond Interest

INT-10 Market Discount

INT-11 Bond Premium

INT-12 Bond Premium on U.S. Treasury Obligations

INT-13 Bond Premium on Tax Exempt Bond

INT-17 State Tax Withheld

1099 R

1099 R Code Description

N/A Not Applicable

R-01 Gross Distribution

R-02a Taxable Amount

R-03 Capital Gain (included in box 2a)

R-04 Federal Income Tax Withheld

R-05 Employee Contributions or Insurance Premiums

R-06 Net Unrealized Appreciation in Employers Securities

R-08 Other

R-09b Total Employee Contributions

R-14 State Tax Withheld

R-17 Local Tax Withheld
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W-2 G Code

W-2 G Code Description

N/A Not Applicable

W2G-01 Gross Winnings

W2G-02 Federal Income Tax Withheld

W2G-14 State Income Tax Withheld

W2G-17 Local Income Tax Withheld

Table 3: Calculation Methods
This table contains calculation methods (and their codes) that are used with Maintain>Accounts

Receivable>Charge Codes, Maintain>Fixed Assets>Custom Depreciation Codes, Maintain>Purchase

Orders>Item Codes; Maintain>Payroll>Earning, Benefit, Deduction, Workers' Compensation, and Leave

Codes; and State and Other Taxes forms.

Accounts Receivable Charge Codes Code

Fixed Amount FA

Fixed Price per Unit FP

Variable Price per Customer VC

Variable Price per Unit VP

Alternative Variable Price/Unit AV

Percent of Account Activity PA

Fixed Asset Custom Depreciation Codes Code

Fixed Amount FA

Fixed Percentage of Depreciable Base PD

Fixed Percentage of Net Book Value PN

MACRS - 31 Years TD



Table 3: Calculation Methods

Fixed Asset Custom Depreciation Codes Code

Percentage Table of Depreciable Base TD

Percentage Table of Net Book Value TN

Inventory Item Codes Code

Average Cost AVG

First In First Out FIFO

Last In First Out LIFO

Payroll Earning Codes Code

Employee Pay Rate ER

Rate Multiplier RM

Fixed Hourly Amount FH

Fixed Amount FA

Amount on Timesheet AT

Rate on Timesheet RT

Payroll Benefit and Deduction Codes Code

Fixed Percentage of Earnings FP

Fixed Hourly Amount FH

Fixed Amount FA

Amount on Timesheet AT

Percentage on Timesheet PT

Payroll Workers' Compensation Codes Code

Rate per $100 Earnings RE

Rate per Workers' Compensation Hours RH

Rate per Hours Worked RW
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Payroll Leave Codes Code

Fixed Number of Hours FN

Fixed Percentage of Hours Worked FP

Amount on Timesheet AT

Percentage on Timesheet PT

Payroll State and Other Taxes Code

Year-to-Date Y

Current C

Table 4: Depreciation Methods
This table contains standard depreciation methods and their codes.

Depreciation Method Code

Straight Line SL

Sum of the Years Digits SYD

150 Percent Declining Balance DB150

200 Percent Declining Balance DB200

No Depreciation Calculated NO

Custom Depreciation Method User Defined

Table 5: Distribution Methods
This table contains distribution methods (and their codes) used with the Maintain>Payroll>Benefit

Codes, Workers' Compensation Codes, and State Taxes forms.

Benefit Codes, Workers' Comp Codes, and State Taxes Code

Follow Earnings on Timesheet AE

Following Earnings Used to Calculate the Tax CE

Use Distribution Code Specified DC



Table 6: Tax Types

Table 6: Tax Types
This table contains a list of payroll taxes (and their codes) used with the Maintain>Payroll>Federal, State,

and Other Taxes forms.

Federal, State, and Other Payroll Taxes Code

Federal Income Tax FIT

Social Security Tax SS

Medicare MC

Federal Unemployment Tax FUTA

Earned Income Credit—no longer applies after Year 2011 EIC

State Withholding Tax SWT

State Withholding Tax—only applies to the Commonwealth of the Northern

Marianas Islands.

SWT2

State Unemployment Tax SUTA

Other Taxes Employee Paid Tax LWT

Other Taxes Employer Paid Tax LER
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Export

Access this form using Export, which is found throughout the system.

Use this form to export data to other file formats. The Data Exporter can export to the following file

types:

Software Version File Extension

Comma Separated Variable *.CSV

HTML Document *.HTM

Microsoft Access® *.MDB

Microsoft Word® *.DOC

Microsoft Excel ® *.XLS

Print Image *.PRN

Word Processing Text *.TXT

XML Document *.XML

Note: Microsoft Excel© is no longer required to view XLS files, however you will need software that

allows you to view Excel files, such as an Excel viewer.

Since the system cannot read invalid characters, ensure that the data being exported is limited to

alphabetic characters (A through Z) or numeric characters (0 through 9), and that it does not contain

symbols. Also, make sure the Administrator has granted you Process rights for the items you want to

export (Security>Set Up Organization Menus and Set Up System Menus).

When exporting reports, the exported data is the result of queries used to produce reports. This process

prevents you from having to create these queries yourself. Keep in mind, the columns may not

necessarily appear in the order specified in the report setup. This is data only; you may need to add page

headers to the exported data.
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Nonprofit Online Users

Files can be saved locally through a mapped drive using the \\TS Client\<drive letter> directory

structure. They are saved to the local computer from within the remote application session. For

specific instructions on how to export a file, see article 4131 in the Knowledgebase. See Nonprofit

Online.

Fields
Save In Select the folder where you want to save the exported file.

File name Either select a file from the list, if appropriate, or enter a file name for the exported data. You

can specify which files are included in the list using the Save as type box.

Save as type Accept the default file type, or select a file type from the drop-down list.

Tips:
Financial statements' underlying queries contain more unformatted data and extra columns than many

other reports. Therefore, financial statements may not be appropriate for exporting.

The currency fields in the exported file, follow the formatting set up in your computer's regional

settings (Start>Settings>Control Panel>Regional Options or Control Panel>Change date, time, or

number formats>Additional Settings Button).

Export to XLS

Access this feature using the Reports>{Any report with this button active}> Export to

XLS. It is not available on all reports.

Use this button to export your active report data to a spreadsheet in a new or existing workbook. Each

time you export data, the system opens a new spreadsheet. This spreadsheet should look very similar to

the report exported from the system. You can choose to maintain or remove the report title from the

header section, the report footer from the footer section, and the report formatting, such as page breaks.

Note: Microsoft Excel© is no longer required to view XLS files, however you will need software that

allows you to view Excel files, such as an Excel viewer.

If you click this button directly on a report, the currency fields in the exported file follow the formatting of

the organization's functional currency regardless of the currency formats used within the report.

However, if you are in the Print to Screen form and the report uses an alternate currency format, this

https://kb.communitybrands.com/node/4131
G_Nonprofit_Online.htm
G_Nonprofit_Online.htm


Export to XLS

button is not available. The functional currency was determined by the Administrator when the

organization was created (File>New Organization>Functional Currency panel).

Some specialized reports may require additional formatting.

The format attributes that will look the same are:

umbrella formatting (indentation of sub items);

font type, size, and weight (such as bold and italic);

underlining (such as column headings and totals);

number/currency formatting; and

report title headings.

Furthermore, the following exceptions and specifics should be taken into consideration:

Word Wrap Exception - The Wrap feature is determined on the Content tab of the report. If it is selected,

wrap is applied to the entire column. These settings carry forward to the spreadsheet. Wrap cannot be

applied to the Items By Page item selected on the Content tab.

Left/Right Alignment Exception - In reports, cells containing dates and amounts are automatically right-

aligned, while all headings (including those of dates and amounts) are left-aligned. Therefore, you can

have a heading with different alignment than its cells. In the spreadsheet, all headings have the same

alignment as the cells; if the cells are left-aligned the heading will be too.

Pagination - the spreadsheet's default top and bottom margins are set to 1", while its left and right

margins are set to .75". the system's default top, bottom, and right margins are set to .5", while its left

margin is set to .75". Consequently, if you view the report in the system, prior to export, the report will

not be exactly the same as when you view it.

When exporting, there is a 500 page limit per spreadsheet; if this limit is reached, the next five hundred

pages are pasted into a new spreadsheet in the same workbook.

Items by Page - Any item that is moved to the Selected Items column in the Items by Page section of the

Content tab will take on the alignment of the first column in the spreadsheet. The system automatically

does this because the Items by Page item will be placed in the first row of the first column, hence

becoming part of the first column.
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Nonprofit Online Users

XLS files can be saved locally through a mapped drive using the \\TS Client\<drive letter> directory

structure. They are saved to the local computer from within the remote application session. For

specific instructions on how to save a file to your computer, see article 4131 in the Knowledgebase.

See Nonprofit Online.

Scheduler Users

Use Reports>Report Binder>Export to XLS . When the Create NewWorkbook option is selected,

the workbook is saved to your My Documents folder on your Desktop, as the Report Binder name with

the system date/time stamp, such as Budgets20141219122618.xls. Also, each report becomes a

separate spreadsheet within the workbook.

Fields
Destination

Create New Workbook If you select this option button, the report data is entered in a new

spreadsheet, in a new workbook.

Append to Existing Workbook If you select this option button, the report data is entered in a new

spreadsheet after all the other spreadsheets, in the existing workbook.

Prepend to Existing Workbook If you select this option button, the report data is entered in a new

spreadsheet before any other spreadsheet, in the existing workbook.

Workbook: Enter the path to the existing workbook or click Browse to locate the existing workbook.

Note that the existing workbook cannot be open when attempting to export.

Remove Report Headers, Footers, and Page Breaks Select this check box to remove the report data's

headers, footers, and page breaks from the new spreadsheet.

Tip: Be sure to save the workbook after you Append to Existing Workbook, otherwise, the last

appended spreadsheet will not be saved.

https://kb.communitybrands.com/node/4131
G_Nonprofit_Online.htm
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